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End-user Software License Agreement 

 

This is a legal agreement between you and Pettersson Elektronik AB. This agreement states the terms 
and conditions upon which Pettersson Elektronik AB offers to license the software “BatSound®” sealed 
in the disk package together with all related documentation and accompanying items (jointly referred to 
as “Software”, and the term “Software” includes but is not limited to executable programs, drivers, 
libraries and data files associated with such programs). 
 
By installing the Software on your computer, you are agreeing to become bound by the terms of 
this agreement. If you do not agree to the terms of this agreement, please do not open the 
sealed CD package (or corresponding). Promptly return, within 30 days, the sealed CD package 
with all its contents and accompanying items to the dealer from whom you obtained it for a full 
refund. 
 

 

LICENSE AGREEMENT 

 
Purchasing a single-user license of the Software licenses you to use the Software only on a single computer. This 
non-exclusive license allows you to install the Software on up to two computers, provided that the Software is used 
on only one computer at a time. If you wish to use the Software on more than one computer at a time, you must 
purchase a separate license or a multi-user license. You may make copies of the Software for backup purposes 
only, but you may not distribute copies of the Software or documentation to others. If you transfer the Software and 
license to another party, you must destroy all copies not transferred. In such case, the new user has to agree to 
become bound by the terms of this agreement. 
 
You may not sublicense, modify, reverse-engineer, disassemble or decompile all or part of the Software. You may 
not use the Software as an application development tool. You may not create, copy, sublicense or distribute a library 
derived from the Software. 
 
 

DISCLAIMER 
 
Pettersson Elektronik AB provides the Software "as is". We specifically disclaim any implied warranties of any kind, 
including, but not limited to the warranties of merchantability and fitness for any particular purpose and against 
infringement. You rely on the Software and results solely on your own risk. The software is not intended for use in 
applications where incorrect functioning/results could result in personal injury or damage to property. 
 
Pettersson Elektronik AB does warrant to the original user that the CD or other storage media on which the Software 
is delivered is free from defects in materials and workmanship under normal use for a period of six months from the 
date of purchase. We will replace the Software CD or other storage media if it proves to be defective during the 
guarantee period, provided that it is returned to us. No other warranty is expressed or implied. We are not 
responsible for any incidental, special or consequential damages. 
 
Pettersson Elektronik AB reserves the right to make changes to the Software and documentation without obligation 
to notify you of such changes. 
 

 

COPYRIGHT NOTICE 
 

The Software and its related documentation are copyrighted by Pettersson Elektronik AB. You may not copy the 
Software or its documentation except for backup purposes without the written permission of Pettersson Elektronik AB. 
 

© Pettersson Elektronik AB 2009-2024. All rights reserved. 
 

BatSound is a registered trademark of Pettersson Elektronik AB. 

Windows is a registered trademark of Microsoft Corporation. 

All other products mentioned in this manual are trademarks of their respective manufacturers. 

 

Version 4.7, August 2024 
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1. Introduction 
 

 

Welcome to the world of advanced sound analysis! 

 

With BatSound you can record, play back, edit and analyze sound on your computer. The advanced 

recording feature allows simultaneous storage of the sound on the hard disk and real-time display of the 

spectrogram and/or oscillogram of the signal.  

 

For the analysis of bat calls, time expanded recordings or recordings made with a high-speed recorder 

(such as the D500X or D1000X detectors) should be used in order to take full advantage of BatSound. 

Recordings made from a heterodyne bat detector are usually not suitable for sound analysis. 

 

 

Some of the BatSound features are: 

 

• Real-time spectrogram 

• Direct hard disk recording of signals 

• Power spectrum 

• Pulse Interval analysis 

• Pulse Length analysis 

• Sound editor including advanced time domain filtering 

• Uses standard sound card for sound input/output 

• Virtual bat detector mode 

• Sound-activated, automatic recording mode 

• Automatic calculation of important pulse characteristics (duration, min/max 

frequency etc.) 

 

 

 

On the BatSound program CD (or other storage media), you will find the file readme.txt, containing the 

latest information and changes not yet available at the time of printing of this manual. Pettersson 

Elektronik's web page, www.batsound.com, may also provide more recent information about the 

software.  
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2. Getting Started 

System requirements 

 

The minimum system requirements for BatSound are: 

 

• An Intel/AMD 1 GHz computer or better 

• RAM: 1 GB minimum (more may be required depending on the Windows version) 

• A Windows compatible sound card 

• >10 GB free hard disk space 

• Windows 7, Windows 8, Windows 10 or Windows 11 operating system  

• Microsoft Visual C++ 2015-2022 Redistributable (x86). If it is not already installed on your 

computer, it can be downloaded from: 

 

 https://aka.ms/vs/17/release/vc_redist.x86.exe 

 

The speed of the computer, its hard disk and graphics card affect the performance of the program. The 

real-time spectrogram display requires high system performance, as does the virtual bat detector. 

 

 

Checking the sound card 

 

A Windows compatible sound card is required for input of sound into BatSound. The sound card has to 

be installed and configured before you run BatSound. Please refer to the instructions accompanying 

your sound card and computer for information on how to install and configure the sound card. 

 

The sound card and related software is not a part of the BatSound package. Please refer any 

questions regarding the sound card and any software accompanying this to the sound card 

manufacturer or distributor! 

 

If you have not already used the sound card, you may want to perform the following tests to verify that 

the sound card is working as it should: 

 

• Use the software included with the sound card to make sure you can record and play sound 

without problems. If necessary, use the appropriate software (e.g. the Volume Control in 

Windows) to adjust the recording and playback levels. Please note that this software is not a 

part of BatSound, so you should refer to the documentation of your sound card and/or 

Windows for information about this.  

• Use the Media Player application (included in Windows, and described in the Windows 

documentation) to play sound. 
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3. Installing the Software 

 

 

To install BatSound, insert the BatSound Installation CD into the appropriate drive in your system. The 

installation process should start automatically within a few seconds. If it does not start automatically, 

please locate the file Batsound4Setup.msi on the CD, using Windows Explorer, and doubleclick on the 

file name to start the installation program. Follow the instructions on the screen to finish the installation. 

 

If you have received the software as a download link, run the file called BatSound4Installer_4836.exe to 

begin the installation process. Please note that you should install Microsoft Visual C++ 2015-2022 

Redistributable (x86) that is mentioned on page 7 prior to this. 

 

Please note that the serial number/license code that you enter during the 

installation is case sensitive. It must be entered exactly as printed on the serial 

number label on the inner back cover of this manual. Entering the wrong serial 

number will result in an error message when the program is launched. If this 

happens, please re-install the software. 

 

If you have received the software as a download link, the serial number/license 

code has been supplied separately. Please make sure to save this code for any 

future use. 
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4. Testing the program 

 

 

After installation of the software, you should perform a few simple tests to verify it is working properly. 

 

Load a sound file 

 

The first step is to load a sound file. The file BATDEMO1.WAV was copied into your 

BatSound/Examples folder (directory) during installation. Choose Open from the File menu and then 

double-click BATDEMO1 in the file list. Make sure the selected File format is includes *.wav files and 

that “Open as: Automatic detection” is chosen. 

 

After loading, the oscillogram (amplitude versus time) and spectrogram (frequency and amplitude 

versus time) of the opened file is displayed on the screen. If you choose the Spectrogram (oscillogram) 

command from the Analysis menu, only the spectrogram (oscillogram) of the signal will be shown 

instead. 

 

Once you have loaded the file, you can also listen to it. Choose Play sound from the Sound menu to play 

the sound file through the sound card. If you wish to listen to a sound file containing a "high-speed 

recording" (i.e. an ultrasonic recording made with a high sampling frequency), you should use the "Play 

Speed" feature to reduce the play speed and obtain a time expanded playback. 

 

 

Make a recording 

 

Connect a suitable sound source to one of the inputs of your sound card (e.g. a tape recorder to the LINE 

input). Make sure the Windows Volume Control* is adjusted to make recording possible on the input 

you have chosen.  

 

Choose New Recording from the File menu and then Record from the Sound menu to start recording. By 

default, the oscillogram and/or spectrogram of the signal are displayed at the same time it is recorded. 

The Recording status dialog box will appear on the screen. You can move this box to the desired part of 

the screen. Make sure the “Real time graphics” box is checked or the signal will not be displayed while 

the recording is made. 

 

The recording continues until you interrupt it by clicking the Stop button in the Recording status dialog 

box. Click Exit to exit the Recording status dialog box. 

 

If the above exercises were successful, then the software and hardware are most probably set up 

correctly. 

 

NOTE: For information on command shortcuts, please refer to Chapter 9 of this manual. 

 

* The name of this Windows utility may be different on your system. 
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5. Tutorial    

 

 

In this tutorial, you will be familiarized with the most common functions in BatSound. The tutorial does 

not cover all functions in BatSound. For detailed information, please refer to chapters 6-9. 

 

Using the Help function 

 

The help function is a convenient way to find answers to your questions about BatSound if you don’t 

have the manual available. Choose Help from the Help menu to open a pdf file of this manual. 

Opening a sound file - controlling the window 

 

To get something to analyze, first open the sound file BATDEMO1.WAV (choose Open from the File 

menu). The signal is displayed in the active window as an oscillogram and/or a spectrogram, depending 

on which selection you make in the Analysis menu (Oscillogram, Spectrogram or Combined). You can 

change the appearance of the diagrams in many ways, and we will now take a look at some of these. 

 

The main window consists of the following: 

 

• The graphics area, where the different diagrams are drawn 

• The title bar 

• The menu bar 

• The toolbar 

• The scrollbar 

• The status bar 

 

 

You can choose to hide/show the toolbar and status bar in the View menu. A check mark next to a 

menu item means that the item will be displayed on the screen. Although it is often an advantage to have 

access to both the toolbar and status bar, hiding one or both will make the graphics area larger, which 

can be desired particularly if you are using a small screen.  
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Figure 1. The BatSound main window. 

 

 

The scrollbar at the bottom of the window can be used to scroll through the sound file. Clicking on the 

arrows (or pressing Ctrl + Left/Right Arrow) results in scrolling in small steps, while clicking on the bar 

to the left or right of the position indicator gives scrolling in larger steps.  

 

Sometimes you may want to take a closer look at a small portion of the signal. Use the zoom function to 

achieve this. First, select the part of the signal you wish to expand. If the Marking Cursor type is used, 

position the marker at the beginning of the desired zoom interval, press the left mouse button down and 

move the marker (mouse) to the end position of the zoom interval, then release the button. The selected 

interval is now shown in inverse colors. Then choose Zoom In from the Tools menu to accomplish the 

zooming, or click the Zoom In button  on the toolbar. 

 

If the Measurement Cursor type is used, it is possible to zoom along both axes in the oscillogram as well 

as the spectrogram. 

 

 

       
 
Figure 2. Zooming. The selected section (left) determines which part to zoom.  
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Changing the size of the window can be made in two ways.  

 

1.  Click the Maximize icon on the menu bar, which makes the sound file window as large as 

possible. 

2.  Use the mouse to drag the size bar at the lower right corner or the edges of the window to the 

desired size.  

 

 

 

Comparing different signals or analysis results is easy in BatSound, since it is possible to have many 

windows open at the same time. To try this, open another sound file (e.g. BATDEMO2.WAV). When 

first displayed, this new signal will occupy the entire graphics area. In order to show more than one 

window, choose Cascade or Tile from the Window menu.  

 

 

       
 
Figure 3. Displaying multiple windows. Cascade mode (left), Tile mode (right). 

 

Playing sound 

 

To play a sound, simply click the Play button in the toolbar or choose Play Sound from the Sound 

menu. This will cause the sound file in the active window to be played. If you have selected a section of 

the sound file prior to choosing Play Sound, only the selected section will be played. Otherwise, the file 

will be played from the current cursor position and to the end of the file. It is always possible to interrupt 

the playback by clicking the Stop button in the toolbar or choosing Stop Play Sound from the Sound 

menu.  

 

Please note that it is possible to unintentionally make a very narrow selection (the marked interval may 

then look almost like the vertical cursor). The following commands may then give unexpected results, 

e.g. choosing Play Sound will cause an extremely small portion of the sound file to be played. 

 

 

Recording sound - The real-time spectrogram 

 

To make a new recording of a sound, first choose New from the File menu, which will open a new, 

empty window. You may want to adjust the recording parameters (sound format and display settings) 

before starting the recording, but if you are satisfied with the current parameter settings, all you have to 

do to start recording is to click the Record button in the toolbar or choose Record Sound from the Sound 

menu. 
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An automatic recording mode is also available, in which the program starts recording as soon as there is 

sound present (like a voice activated tape recorder). To use this mode, use the “Automatic Recording” 

command in the Sound menu. Please refer to chapter 9 for more detailed information.  

 

The sound format (bit depth, stereo/mono, sampling frequency) is selected through the Sound Format 

command in the Sound menu. The selected parameters only apply to new recordings. Recordings 

already made, of course retain the above sound parameters. The sampling frequency, however, can be 

changed in an existing sound file. This should be done only in very special cases and only by 

experienced users.  

 

The time expansion factor can also be changed in the Sound Format dialog. Normally a time expansion 

factor of 1 is used. However, when time expanded signals are analyzed, the time expansion factor is used 

to automatically adjust time and frequency values on the axes. This parameter may be changed even 

after a recording has been made. 

 

Comments to describe the sound file can also be entered in the Sound Format dialog. These comments 

will be stored in the file, provided it is saved in one of the BatSound File Formats.   

 

The Spectrogram settings – default command (Analysis menu) allows you to change the time axis 

scale and to set the spectrogram parameters for all spectrogram to come. To change the settings in an 

existing spectrogram, use the Spectrogram settings command in the “right mouse button” menu. In the 

Oscillogram settings dialog (Analysis menu) a few oscillogram parameters can be changed.  

 

For more information about the real-time spectrogram, please refer to chapter 6, "The real-time 

spectrogram". 

 

If a sound file is already displayed in the active window, you may also continue recording to this file. 

Simply click the Record button (or Record Sound in the Sound menu) to start recording. The new 

recording will be appended to the existing file, using the same sound format as this. 

 

Analysis  Please refer to Appendix A for more detailed information on the different analysis types! 

 

• The Power Spectrum 

 

The Power Spectrum shows the frequency contents of the signal as signal power versus frequency. The 

power (Y-axis) is here given in dB FS (Full Scale), i.e. relative to the maximum level (0 dB). A linear 

power scale can also be chosen. The Power Spectrum is calculated via the FFT (Fast Fourier 

Transform). Choose Power Spectrum Settings to enter new parameters (FFT size, FFT window and 

scaling) if desired.  

 

The power spectrum is calculated over a limited portion of the signal, so first you should select the time 

interval for the calculation. This can be done in two ways: 

 

1.  Mark the starting point of the interval over which you wish to calculate the power spectrum. 

The FFT size given under Power Spectrum Settings determines the length of the interval, 

which is shown in inverse colors.  

 

2.  Mark the desired time interval over which you wish to calculate the power spectrum. A 

number of FFTs are calculated over this interval, and then averaged before being displayed. A 

small overlap between successive FFTs will be used to fit the FFTs into the desired time 

interval. 

 

Then choose Power Spectrum from the Analysis menu. An example of a power spectrum is given below. 
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By clicking the right mouse button somewhere in the Power Spectrum window, a menu is invoked from 

which you may choose the command Settings. This will open the Power Spectrum Settings dialog box, 

where you can change the settings for the Power Spectrum currently shown in the window. To select the 

default settings for a Power Spectrum (i.e. the settings used for all new Power Spectrum analyses), you 

should use the Power Spectrum Settings command in the Analysis menu (please refer to the Commands 

Overview section on page 58-59 of this manual for more information on the settings).  

The "right mouse button" menu in the Power Spectrum also allows you to print the Power Spectrum or 

to copy it to the clipboard. 

 

It is also possible to display the power spectrum in the continuous update mode, meaning that the 

power spectrum is continuously updated as the power spectrum settings are changed. E.g. if you mark a 

new interval in the oscillogram or spectrogram (to indicate where the power spectrum should be 

calculated), the power spectrum will immediately be computed and displayed for the new interval. 

 

This is particularly useful for examining how the power spectrum changes while scrolling through a 

spectrogram (use the arrow keys to move the cursor through the spectrogram). Note that the actual 

interval over which the power spectrum is calculated is always shown. 

 

 
 
Figure 4. A power spectrum (power vs. frequency). 
 

 

• The Spectrogram 

 

The spectrogram basically consists of a large number of power spectra, calculated one after the other 

along the signal. That way the spectrogram is able to show how the power spectrum of the signal 

changes over time. In order to represent this 3-dimensional information (power and frequency vs. time) 

in a 2-dimensional diagram the power has been coded into different colors or different shades of gray. 

 

In the Spectrogram Settings dialog box, the FFT size and FFT Window can be chosen, just like in the 

Power Spectrum settings dialog box. For the spectrogram some additional parameters may be entered; 

the overlap between FFTs, the way the power is mapped into different colors and the time scale for each 

window. 
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To calculate a spectrogram, adjust the settings if necessary and make sure the active window contains an 

oscillogram (or spectrogram) of the signal you want to analyze. Then choose Spectrogram from the 

Analysis menu or click the Spectrogram button in the toolbar.  

 

If the resulting spectrogram is too weak (only visible where the signal is strongest) or if the noise is too 

conspicuous, you may need to adjust the Amplitude Threshold in the Spectrogram Settings dialog box. 

This can also be made by holding the Shift key and clicking the arrows to the left and right of the color 

bar in the diagram window. Clicking the arrows without holding the Shift key will affect both the 

Amplitude Threshold and Contrast. 

 

An example of a spectrogram is given below. 

 

 
 
Figure 5. A spectrogram (frequency and power vs. time). 
 

  

 

 

• The Pulse Interval and Pulse Length Analyses 

 

These two analysis types both result in a histogram showing the distribution of the time intervals 

between successive pulses and pulse lengths respectively. 

 

To make this analysis, make sure the active window contains an oscillogram of the signal you want to 

analyze. When you choose Pulse Length/Interval Analysis from the Analysis menu, two horizontal 

cursors appear in the oscillogram. Using the mouse, adjust the cursors slightly above the noise floor and 

check that the cursors intersect all pulses you want to include in the analysis (only pulses exceeding the 

cursor level will be counted).  
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In the Pulse Interval/Pulse Length Settings dialog box you should enter values for the Detection Delay 

Time, Histogram Start/End time and Histogram bar width (please refer to the Pulse Interval/Pulse 

Length Settings command description in the command section of this manual). If "Automatic 

Calculation…" is checked, all parameters expect the Detection Delay Time will be calculated 

automatically and any values manually entered will be disregarded.  

 

“Right mouse button” menus 

 

Clicking the right mouse button in a diagram will invoke a menu with a number of commands often used 

in that type of analysis. Using this menu rather than the main menus gives you quicker access to these 

commands.  

 

In a few cases, the commands in the right mouse button menu have no counterpart in the main menus or 

work in a slightly different fashion. For more detailed information on the commands in the right mouse 

button menu, please refer to the section on the respective analysis type in chapter 9 of this manual. 
 

Editing the signal 

 

There are many ways you can edit the sound files. In this section only a few of these are mentioned. 

In all cases, only the selected portion of the signal will be edited.  

 

If the signal you have recorded is too weak, you may wish to amplify it. Choose Adjust Volume from the 

Edit menu and enter a suitable factor (200% means that the amplitude will become twice the original 

amplitude). Please note that for optimum sound quality, you should try to adjust the recording volume so 

the resulting recording level is appropriate instead of adjusting the volume by editing the sound file.  

 

Sometimes there is noise or other unwanted sounds in a recording. These sounds can often be reduced or 

removed by applying a filter. The filter removes or attenuates certain signal frequencies, according to 

the selections you make.’ 

 

Exporting analysis data 

 

Sometimes you may wish to export the numerical results from the analyses to other programs, e.g. to 

perform statistical analysis in a spreadsheet program. The following types of information can be 

exported: 

 

Power Spectrum data. Use the “Copy Ascii” command in the “right mouse button” menu of the Power 

Spectrum to copy the numerical values making up the diagram to the Windows clipboard. The same data 

can also be written directly to a text file by using the “Ascii File Export” command from the right mouse 

button menu. Please refer to the Power Spectrum Command section in chapter 10 for more information. 

 

Pulse Interval/Pulse Length Analysis data. Use the “Copy Ascii” command in the “right mouse 

button” menu of the Pulse Interval/Pulse Length diagram to copy the numerical values making up the 

diagram to the Windows clipboard. Please refer to the Pulse Interval/Pulse Length Analysis Command 

section in chapter 10 for more information. 

 

Oscillogram data. Use the “Copy Ascii” command in the “right mouse button” menu of the 

Oscillogram to copy the numerical values making up the diagram to the Windows clipboard. Please 

refer to the Oscillogram Command section in chapter 10 for more information. 

 

Mark Distances data. Use the “Copy” button in the “Mark Distances” dialog box (Tools menu) to copy 

the data from the Mark Distances table to the Windows clipboard. 
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Pulse Features data. Use the “Copy” button in the “Pulse features” dialog box to copy the data from the 

table to the Windows clipboard. 

 

NOTE: To open the “right mouse button” menu, position the cursor anywhere in the diagram and click 

the right mouse button. 
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6. The Real-time Spectrogram 

 

The real-time spectrogram mode with simultaneous hard disk recording of the signal is a very useful 

operating mode of BatSound. Using this mode, you are able to visually follow the signal by looking at 

the spectrogram and/or oscillogram running over the screen and at the same time, the signal is stored on 

the hard disk. This means that you, after interrupting the recording, can scroll through selected parts of 

the sound file again and, if desired, make a more detailed analysis of the interesting parts. 

 

The spectrogram of a signal is displayed in real time each time a recording is made (Record command in 

the Sound menu), provided that the current window is set up for displaying spectrograms (click the 

Spectrogram button in the toolbar to set up the window to display spectrograms). 

 

The main sound file type in BatSound is the commonly used Wave file. Also, the different BatSound file 

formats are based on Wave files. The BatSound wave formats, however, also contain additional 

information about the recording. The table below shows the resulting file sizes for some different 

formats and recording lengths. 

 

 

Format Approximate file size in MB 

  10 sec. recording     30 sec. recording    60 sec. recording 

Maximum signal 

frequency (appr.) 

kHz 

44.1 kHz, 16 bits, 

mono 

0.88 2.6 5.2 20 

44.1 kHz, 16 bits, 

stereo 

1.76 5.2 10.5 20 

96 kHz, 16 bits, 

mono 

1.9 5.7 11.5 45 

192 kHz, 16 bits, 

mono 

3.8 11.5 23 90 

384 kHz*, 16 bits, 

mono 

7.7 23 46.1 180 

 

* Recording at this sampling frequency is not possible with all Windows versions. 

 

Please note that the real-time spectrogram mode uses a great deal of the computer's system resources; 

the signal has to be sampled and the samples copied to the file on the hard disk, a large number of FFTs 

have to be computed, coded and finally sent to the screen as a spectrogram. Some factors affecting the 

success of this are: 

 

 The processor speed  

 The access time of the hard disk 

 The speed of the graphics card 

 

 

If the overall performance of the system is not sufficient, the display of the spectrogram may be delayed 

and if the memory buffers are exhausted, finally some signal samples may be lost. 
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How do I know when there is a problem? 

 

If you notice the drawing speed of the progressing oscillogram/spectrogram becomes lower and that the 

sound from the loudspeaker and the signal drawn on the screen are not synchronized, then the system 

has problems coping with all of its tasks.  

 

If you hear "clicks" in the recorded sounds when you replay them, then some samples were probably 

lost. This too is a sign of insufficient system resources. 

 

What can be done to increase system performance? 

 

The first thing you should check is the setting of the "Threshold" in the Spectrogram Settings dialog box. 

The amplitude Threshold determines the level of the weakest signal to be displayed in the spectrogram. 

If this is set too low, all weak parts of the signal and much of the noise will be shown in the spectrogram, 

resulting in a slower display (drawing graphics on the screen is a time-consuming task for the 

computer!).  

 

So, try to set the Threshold to a higher level if possible (remember that you can always return to the 

signal when the recording has been stopped, to make a more detailed analysis with any analysis settings 

you might choose). This will make the display more rapid. 

 

Using a smaller FFT size and/or smaller overlap (see the Spectrogram settings command) will also make 

the display of the spectrogram faster. Setting Overlap to Automatic is usually the best choice in order to 

reduce the system load. 

 

Using a smaller window to display, the waveforms during recording will make the display faster. 

 

Using "Mono" instead of "Stereo" if possible will decrease the load on the system. 

 

Using a lower sampling frequency if possible will decrease the load on the system. 

 

You should make sure no other applications are running at the same time as BatSound, particularly 

applications trying to access the hard disk or write to the screen. 

 

The speed of the hard disk can be gradually decreased, as the disk is filled and the files are being 

fragmented. There are many utility programs that can be used to defragment a hard disk, one of which is 

the Windows utility Defrag.   

 

Finally, you could try to fine-tune the performance of the computer by running the SETUP utility 

(usually available by hitting a special key during system boot-up). The way to do this depends on your 

hardware, so please refer to the User’s Manual of your computer for information about this. 
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7. The Virtual Bat Detector Mode 

 

 

In the Virtual Bat Detector mode, time expanded (or high-speed recorded) sounds are replayed at their 

original speed, as heard through a heterodyne bat detector. In order to understand this mode, some basic 

knowledge about heterodyne detectors is required. The Virtual Bat Detector mode will only work with 

mono sound files. 

 

 

 

Heterodyne bat detectors 

 

A heterodyne bat detector is a narrowband detector meaning that only a limited portion of the entire 

ultrasonic frequency range is converted into audible sounds at each time. A tuning control is used to 

select the center frequency of the range to make audible. Let us assume the width of this range is about 

10 kHz (which may be considered a "normal" bandwidth). If the tuning control is set to 30 kHz, this 

means that the range 25 to 35 kHz will be made audible. The frequency of the converted signal equals 

the difference between the original ultrasonic frequency and the tuned frequency, so if the ultrasound 

has a frequency of 29 kHz, the resulting audible frequency will be 1 kHz at a tuned frequency of 30 kHz. 

Obviously, the same result will be obtained for an original frequency of 31 kHz. 

 

The heterodyne technique has several advantages; it gives a relatively cheap design, it offers high 

sensitivity and it enables the user to, at least roughly, determine the frequency of the ultrasound. The 

resultant audible sound also has tonal qualities, like "ticks" and "smacks", telling the user more about the 

type of call. A constant frequency (CF) pulse gives a smacking sound, while a frequency modulated 

(FM) sweep pulse results in a ticking sound. An FM sweep pulse, leveling out to a CF portion will give 

a ticking sound when the detector is tuned to the frequency range of the sweep, but a smacking sound if 

tuned to near the frequency of the CF portion. Hence, it is important to tune the detector properly in each 

situation, in order to extract as much information as possible about the signal.  

 

 

The Virtual Bat Detector principle 

 

Given the large number of bat species, each using a number of different types of calls, it should come as 

no surprise that it usually takes quite some time to learn how to identify the different species with a bat 

detector. The main idea with the Virtual Bat Detector is to facilitate this learning process. The Virtual 

Bat Detector emulates a heterodyne bat detector using time expanded or high-speed recorded sound 

files. An on-screen tuning control is available which may be adjusted while the sound file is being 

played - just like a real bat detector! An important advantage with the Virtual Bat Detector is that the 

spectrogram of the signal is displayed while it is being replayed, with the tuned frequency clearly shown 

both graphically (as a horizontal bar) and with digits. This makes it very easy to understand the 

connection between the spectrogram and the different sounds heard in a heterodyne detector, at different 

frequency settings. 
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Figure 6. The Virtual Bat Detector replay screen. The tuned frequency is displayed in the lower left corner and also indicated with the 

horizontal bar. 

 

As was mentioned above, only a portion of the entire ultrasonic frequency range can be made audible at 

each time. This is achieved by using a filter in the heterodyne detector. It is the characteristics of this 

filter that determines the width of the frequency range to transform. The Virtual Bat Detector uses a 

filter in a similar fashion, and in order to make it as versatile as possible, the characteristics of this filter 

can be changed (see below). 

   

 

Using the Virtual Bat Detector with time expanded recordings 

 

Before running the Virtual Bat Detector, you should prepare one or more sound files to be played. As 

mentioned previously, time expanded or high-speed recorded sound files should be used. Please note 

that only mono sound files can be used in the Virtual Bat Detector mode. A few example sound files are 

supplied with BatSound, so to test this mode you can use the file "Virt1.wav". This file contains a 

sequence of bat calls time expanded 10 times. If the appropriate time expansion factor (accessible via the 

Sound Format command in the Sound menu) has not already been entered, it is advisable to do so before 

continuing. This will make the filter design procedure easier. 

 

To change from the normal mode to the Virtual Bat Detector mode, select "Virtual Bat Detector" from 

the Sound menu. This invokes the "Start Virtual Bat Detector" dialog box.  

 

First, the "speed factor" should be entered. If you are using the "Virt1.wav" file, you should enter 10 (i.e. 

the time expansion factor). Next, you should specify the filter characteristics to use. Click the "Select 

Filter" button to enter the filter design dialog box (see below). For maximum versatility, you may select 

any filter type. However, to emulate a standard heterodyne bat detector, a lowpass filter should be 

selected. You should leave the check box “Use the speed factor to calculate play speed” unchecked. 
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Figure 7. The filter design dialog. 

 

If the time expansion factor has been entered as recommended above, the filter's cut-off frequency ("fc" 

in the dialog) should be chosen to be half of the desired bandwidth of the detector. E.g. to obtain the 

bandwidth from the example above (10 kHz), you should choose a cut-off frequency of 5000 Hz. If you 

have not entered the appropriate time expansion factor in the Sound Format dialog box, you will have to 

compensate for this manually, meaning that you should choose a cut-off frequency of 5000/10 = 500 Hz 

instead.  

 

You may select any of the available filter types and filter orders. If you are uncertain of what to choose, 

try a 2nd order Butterworth filter. The higher filter order the sharper cut-off, but also the heavier 

computational burden on the computer, so particularly if the computer is not one of the faster, you 

should use a low order filter (e.g. 2nd order). 

 

Now you are ready to play the sound file through the Virtual Bat Detector. Press the "Play" button in the 

toolbar or select "Play Sound" in the Sound menu. The file is now played at the original rate, meaning it 

will be replayed n times faster than when replayed in the normal mode (n = the time expansion factor = 

10 in the example). The tuned frequency is indicated as a short horizontal bar and is also displayed with 

digits in the lower left corner of the window. Use the up and down arrow keys to change the setting of 

the tuning control. Under certain circumstances, there will be a delay in the tuning control's response to 

pressing the arrow keys. Usually this is because the computer performance is not sufficient for the 

selected Virtual Bat Detector parameters (filter order and speed factor). High filter orders and 

high-speed factors will require higher computer performance to work well. 

 

When a sound file is replayed through the Virtual Bat Detector, the duration of the sound is shorter than 

if the file was replayed in the normal mode (for a speed factor of 10, the duration is one tenth). Hence 

you will need quite long sequences of time expanded signals. If you have problems finding sufficiently 

long sequences, you might want to use a few shorter sequences and paste them together to a longer 

sequence.  
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Using the Virtual Bat Detector with high-speed recordings 

 

If the file you intend to play through the Virtual Bat Detector contains high-speed recorded sound (i.e. 

the sound in the file is not time expanded), most of what is said in the previous section still holds. There 

are, however, a few important differences. 

 

In the Start Virtual Bat Detector dialog box you should check the box “Use the speed factor to calculate 

play speed” and select a speed factor that results in a “play speed” (play sampling rate) that is supported 

by the sound card. E.g. if the sampling rate in the sound file is 400000 Hz, you could enter a speed factor 

of 10 to obtain a “play speed” of 40000 Hz (which is supported by a standard sound card). Changing the 

speed factor will not change the time it will take to play the file, only the playback sampling rate. 

  

 

What if it doesn't work? 

 

The horizontal bar showing the tuned frequency is not visible. 

 

A spectrogram has to be displayed in the active window in order for the tuning control to be active. 

Make sure you have selected this before running the Virtual Bat Detector. 

 

The tuning control does not move when I press the arrow keys. 

 

The computer's performance may be inadequate for the selected Virtual Bat Detector parameters (see 

above). Try a lower filter order and/or a lower speed factor if possible. On a sufficiently fast computer, 

the tuning indicator should move with no or small delay when you press the up/down arrow keys. 

 

 

Exiting the Virtual Bat Detector mode  

   

In order to exit the Virtual Bat Detector mode and return to the normal mode, open the Sound menu. As 

you see, the "Virtual Bat Detector" command is checked. Select the "Virtual Bat Detector" command 

again to uncheck this alternative.  
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8. BatSound Commands Overview 

 

In this section, you will find a short description of all commands available in BatSound. The commands 

are listed according to the menu in which they occur. 

 

File menu commands 

 

The File menu offers the following commands: 

 

New  Opens a new file to make a sound recording. 

Open Opens an existing document (sound file). 

Open 

Next/Previous 

Opens the next/previous sound file (in alphabetic order) 

Close Closes an opened document (sound file). 

Sort files Allows user to move files to folders with dedicated shortcuts 

Automatic scan 

for pulses 

Toggles an automatic scan on and off. This utilizes pulse feature analysis 

Automatic time 

expansion 

Setting for automatically assigning a time expansion factor for files below a 

designated sample rate 

Save Saves an opened document (sound file) using the same file name. 

Save As Saves an opened document (sound file) to a specified file name. 

Save Selected 

Interval 

Saves the selected section of the sound file to a specified file name. 

Import Imports and opens an existing document (sound file) in a non-standard format 

(e.g. mp3). 

Export Graphics Saves the current main diagram (oscillogram/spectrogram) to a file (e.g. bmp, 

jpg, tif).  

D500X/D1000X 

File Management 

Functions for managing D500X/D1000X files. Presents embedded file 

information and has easy copy and file rename function. 

Print Prints the diagram in the active window. 

Print Preview Displays the diagram on the screen, as it would appear printed. 

Print Setup Selects a printer and printer connection. 

File properties Displays the properties for the active sound file 

Exit Exits BatSound. 

 

 

Edit menu commands 

 

The Edit menu offers the following commands: 
 

Undo  Reverses previous editing operation. 

Cut Deletes the selected section of the sound file and moves it to the clipboard. 

Copy Copies the selected section of the sound file and the diagram in the active 

window to the clipboard. 

Copy Ascii Copies the numerical values that form a certain diagram to the Windows 

clipboard. 

Paste Pastes data from the clipboard into the sound file. 

Select All  Selects the entire sound file. 

Delete  Deletes the selected section of the sound file from the document. 

Clear/silence  Replaces the selected section of the sound file with silence. 

Reverse  Time-reverses the selected section of the sound file. 

Adjust Volume  Changes the gain of the selected section of the sound file. 
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Filter  Performs time-domain filtering of the selected section of the sound file. 

Reset settings Resets various settings in the program to default values. 
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View menu commands 

 

The View menu offers the following commands: 

 

Toolbar Shows or hides the toolbar. 

Status Bar Shows or hides the status bar. 

 

 

Window menu commands 

 

The Window menu offers the following commands, which enable you to arrange multiple views of 

multiple documents in the application window: 

 

Cascade Arranges windows in an overlapped fashion. 

Tile Arranges windows in non-overlapped tiles. 

 

 

Sound menu commands 

 

The Sound menu offers the following command: 

 

Sound Devices  Displays information about the installed sound devices. 

Play Sound  Plays the currently selected section of the sound file.  

Move to 

beginning of file 

Makes the cursor move to the beginning of the file. 

Move to end of 

file 

Makes the cursor move to the end of the file. 

Play Speed Selects which speed to use for playback of sounds. 

Record Sound  Starts recording to the selected file, with optional display of the spectrogram 

and/or oscillogram in real time. 

Pause Play 

sound 

Pauses playing sound. To resume playing, select Play sound. 

Stop Play sound  Stops playing sound. 

Sound Format  Selects the sound format for recordings from the regular sound card (bit depth, 

stereo/mono, sampling frequency and time expansion factor). Also used to 

save comments in the sound file. 

Automatic 

recording 

Selects the Automatic recording mode, in which BatSound automatically starts 

a recording as soon as there is sound present. 

Virtual Bat 

Detector 

Selects the Virtual Bat Detector replay mode. 
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Tools menu commands 

 

The Tools menu offers the following commands: 

 

Zoom In Zooms in on the selected section of the sound file. 

Zoom Out Changes the zoom level back one step. 

Default Zoom  Restores the displayed sound file to the original zoom level.  

Zoom Entire File Adjusts the zoom level so that the entire sound file fits into the active window. 

Zoom full range 

frequency/ampli

tude 

Adjusts the zoom vertical zoom level so that the full frequency and amplitude 

range is shown 

Marking cursor  Selects cursor type to allow selecting (marking) portions of the signal. 

Marking cursor - 

stereo 

Selects cursor type to allow selecting (marking) both channels of a stereo file. 

Measurement 

cursor/Large 

measurement 

cursor  

Selects cursor type to allow display of time and frequency values (absolute and 

relative). Also used for window zoom in oscillograms and spectrograms. 

Level cursor Selects cursor type used for pulse interval/length analysis. 

Save cursor as 

mark 

Puts a "mark" at the current cursor position. 

Set active mark Selects the active mark. 

Active mark 

properties 

Changes the properties (label, type of mark) of the active mark. 

Move active 

mark 

Enables/disables changing the position of the active mark using the arrow 

keys. 

Mark distances Displays a table (matrix) showing distances between the marks. 

Scroll to mark Scrolls the sound file to the selected mark. 

Clear all marks Deletes all marks. 
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Analysis menu commands 

 

The Analysis menu offers the following commands: 
 

Spectrogram  Displays the spectrogram of the signal in the current active window.  

Oscillogram  Displays the oscillogram (envelope curve) of the signal in the current active 

window.  

Combined  Displays both the spectrogram and the oscillogram of the signal in the current 

active window. 

Power 

Spectrum  

Displays the power spectrum of the signal. 

Pulse Interval/ 

Pulse Length 

Analysis  

Displays pulse interval and pulse length diagrams of the signal. 

Pulse Feature 

Analysis 

Displays important pulse characteristics (min/max frequency, duration etc) in  

a table. 

Spectrogram 

Settings - 

Default  

Changes the default analysis parameters for Spectrograms. 

Oscillogram 

Settings - 

Default 

Changes the default display parameters oscillograms. 

Power Spectrum 

Settings - Default 

Changes the default analysis parameters for Power Spectra.  

Pulse Interval/ 

Pulse Length 

Analysis Settings 

- Default  

Changes the default analysis parameters for Pulse Interval and Pulse Length 

Analysis diagrams. 

 

 

Help menu commands 

 

The Help menu offers the following commands, which provide you assistance with this application:  
 

Help Opens the BatSound User’s Manual (as a pdf file). 

Help on the web Links to the Help page at the Pettersson web site. 

Pettersson 

homepage 

Links to the main page at the Pettersson web site. 

About Displays the version number etc. of this application. 
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9. BatSound Commands 

 

In this section a detailed description of each command is given. The commands are listed in the same 

order they appear within each menu. 

The File menu 

 

 

New command (File menu) 

 

Use this command to open a new, empty sound file. Typically, you would choose this command to make 

a new recording or to paste data from the clipboard when you are editing files.  

 

To start recording to the file, choose Record Sound from the Sound menu, or click on the red “Record” 

button in the toolbar. The oscillogram and/or spectrogram is displayed at the same time the signal is 

stored on the hard disk. 

 

You can open an existing document/sound file with the Open command. 

 

Shortcuts 

Toolbar:  

 

Keys: CTRL+N 
 

 

 

Open command (File menu)  

 

Use this command to open an existing document/sound file in a new window.  You can open multiple 

documents at once.  Use the Window menu to switch among the multiple open documents.  See Window 

1, 2, ... command. 

 

The default file extension is .wav and .bsnd, but other formats may be chosen in the File Open dialog 

box.  

 

Shortcuts 

Toolbar:  

 

Keys: CTRL+O 
 

 

 

File Open dialog box 

 

The following options allow you to specify which file to open: 

 

File Name 

Type or select the filename you want to open.  This box lists files with the extension you select in the 

List Files of Type box.  

List Files of Type 

Select the type of file (extension) you want to open.  
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Please note that "Data files" (.dat and .raw files) do not contain any information about the sampling 

frequency used to make the recording, so in order to obtain the correct frequency and time in the 

diagrams, the sampling frequency of the sound file must be changed manually in the Sound Format 

dialog. All other file types already contain information about the sampling frequency and no further 

action is required. 

Drives 

Select the drive in which BatSound stores the file that you want to open.  

Directories 

Select the directory in which BatSound stores the file that you want to open. 

Open as 

Select the file format for the file you want to open. The “Automatic detection” alternative means 

that the program attempts to determine the file format. If you experience problems using this 

alternative, please use one of the other, “manual” alternatives.  

 

The D500X/D1000X alternative is for .wav files created by the D500X/D1000X ultrasound 

detectors. It will retrieve the extra information in these files, such as recording date/time and GPS 

data (if available). 

 

 

 

Open next/previous commands (File menu)  

 

Use this command to open the next file in alphabetic order. This is useful if you are going through a large 

number of files with names in sequential order, e.g. M00001.wav, M00002.wav… 

 

The command is only available when there is at least one file open. If there is more than one file open, it 

is the active file that is used to determine the next file to open. 

 

If the active file is a non-wave file, e.g. an mp3 file, this command will import and open the next mp3 

file. 

 

Shortcuts 

 

Toolbar:    

 

Keys: N B 

 

 

 

Close command (File menu)  

 

Use this command to close all windows containing the active document/sound file. Before closing an 

untitled document, BatSound displays the Save As dialog box and suggests that you name and save the 

document. 

 

You can also close a document by using the Close icon  on the document's title bar or menu bar.
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Sort files (File menu) 

 

This tool allows you to manually sort files with up to 20 shortcuts (0-9, CTRL+0-9). When a shortcut is 

pressed, the active file will be moved to the corresponding, user-defined location. The file will then 

close and the next file in the folder will open, allowing for quick sorting. 

 

In the Settings menu, a number of different settings can be made. The “In use” checkbox determines 

whether a shortcut will be enabled or not. You can also manually enter the path into the textbox. 

 

By checking the Copy box, files will not be moved when a shortcut is pressed. Rather, the original file 

will remain in its location and instead a copy of the file will be created in the target location. 

 

By entering text of your choice in the corresponding boxes, you can add a prefix and/or suffix to the file 

name. Checking the boxes for Recording and GPS data will add further information to the file name. 

 

 

 

 

Automatic Time Expansion Factor (File menu) 

 

When enabled, these settings are applied when a file with no time expansion factor is opened. If the file 

has a sample rate lower than the designated one, the user-defined time expansion factor will 

automatically be used. 

 

 

Save command (File menu)  

 

Use this command to save the active document/sound file to its current name and directory.  When you 

save a document for the first time, BatSound displays the Save As dialog box so you can name your 

document.  If you want to change the name and directory of an existing document before you save it, 

choose the Save As command. 

 

Shortcuts 

Toolbar:  

 

Keys: CTRL+S 

 

 

 

Save As command (File menu)  

 

Use this command to save and name the active document/sound file. BatSound displays the Save As 

dialog box (see below) so you can name the file.   

 

To save a document with its existing name and directory, use the Save command. 

 

 

 

Save Selected Interval command (File menu)  

 

Use this command to save and name the selected interval of the active document/sound file. BatSound 

displays the Save As dialog box (see below) so you can name the file. 
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Import command (File menu) 

 

Use this command to import and open a non-wave file, e.g. an mp3 file. This command uses the codecs 

for various file formats that are already installed on the computer, so which file types that can be 

imported depends on which codecs have been installed on the computer. 

 

After importing and opening a non-wave file, the text “converted” will appear in the title bar along with 

the file name. 

 

 

 

Export Graphics command (File menu)  

 

Use this command to create a picture file with the current main diagram (oscillogram and/or 

spectrogram). The selectable file formats depend on which codecs are installed on the computer, but 

typically include bmp, jpg, gif, tif, png and emf. 
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D500X/D1000X File Management command (File menu) 

 

This command opens the File Management dialog box which gives a list of the D500X/D1000X 

ultrasound detector files in the selected folder with the embedded file information: 

 

File name 

Time and date of recording 

GPS latitude and longitude (if available) 

Original file name 

D500X/D1000X firmware version 

 

 
 

The information in the File Management list can be exported to a tab separated text file (“Export”). 

Select the desired information to export by first highlighting it. It is also possible to press Ctrl-C to copy 

the highlighted section to the Windows clipboard. 

 

The Copy & Rename function is used to copy one or more D500X/D1000X files from the CF card to the 

computer’s hard disk. Optionally the files can also be renamed. The Rename function can also be used to 

add the time and date to the original file name. A user defined prefix and/or suffix can be added to the 

original file name. Selecting multiple files, will create copies of all files with time/date, prefix and suffix 

added. This is useful to add identification information (e.g. recording location) to a group of 

files. As an example, if the settings showed below are applied to the file M00067.WAV above, this will 

result in a copy of the file to the file ABC2010-10-01_11_16_45_M00067DEF.WAV in the C:\temp 

folder. 
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File Save As dialog box 

 

The following options allow you to specify the name and location of the file you're about to save: 

 

File Name 

Type a new filename to save a document/sound file with a different name.  BatSound adds the 

extension you specify in the Save File As Type box. The default extension is .bsnd. 

File Format 

The following file formats are available: 

 

BatSound data file (*.bsnd) - A wave format with embedded information used by BatSound, 

e.g. comments and certain display parameters. 

BatSound file pairs (*.wav, *.bsndp) – The extra information which is embedded in the 

BatSound data files is here stored in a separate file with extension .bsndp and the .wav file is a 

standard wave file that can be read by other programs.  

BatSound wave file  - A wave format with embedded information used by BatSound, e.g. 

comments and certain display parameters. This file format is compatible with BatSound version 

3 wave files. 

BatSound compressed wave file  - A wave format similar to BatSound wave, that does not 

save the “silent” portions of the signal, which in most cases gives a significant reduction in file 

size. When a file of this type is opened again in BatSound, silent periods are automatically 

inserted between the calls, to retain the original time relations. 

When this format is selected, the user is prompted for the threshold level (below which the 

signal is not saved) and the time interval before and after the pulse where the signal still should 

be saved, even though it does not reach above the threshold. This avoids abruptly cutting of the 

pulses.  

D500X/D1000X files – A wave format for files recorded with the D500X or D1000X 

ultrasound detectors. The format has embedded information about the recording, e.g. time/date 

and (for the D1000X) GPS data. It should be chosen when a D500X/D1000X file has been 

edited and you wish to save it without losing this embedded information. Choosing this format 

will not create a D500X/D1000X type of file from a standard wave file. 

Wave files  – The regular wave format. BatSound can read this format as well, but no BatSound 

specific information will be stored in the file. Typically, this format should be used to create 

files to be read by other applications, not capable of reading the BatSound wave format. 

Data file – Only the raw samples are stored sequentially in the file. No information about 

sampling frequency etc. is stored. Typically, this format should be used to create files to be read 

by other applications, not capable of reading wave files.  

 

 

 

Print command (File menu)  

 

Use this command to print a document (diagram). This command presents a Print dialog box, where you 

may specify the range of pages to be printed, the number of copies, the destination printer, and other 

printer setup options. 

 

Note: To print other diagrams than those in the main windows, e.g. a power spectrum, position the 

cursor in the power spectrum window and click the right mouse button to invoke a menu with the print 

command. 
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Shortcuts 

Toolbar:  

 

Keys: CTRL+P 

 

 

 

Print Preview command (File menu)  

 

Use this command to display the active document, as it would appear when printed.  When you choose 

this command, the main window will be replaced with a print preview window in which one or two 

pages will be displayed in their printed format.  The print preview toolbar offers you options to view 

either one or two pages at a time; move back and forth through the document; zoom in and out of pages; 

and initiate a print job. 

 

 

 

Print Setup command (File menu)  

 

Use this command to select a printer and a printer connection.  This command presents a Print Setup 

dialog box, where you specify the printer and its connection. 

 

 

 

Print Setup dialog box 

 

The following options allow you to select the destination printer and its connection. 

Printer 

Select the printer you want to use.  Choose the Default Printer; or choose the Specific Printer option 

and select one of the current installed printers shown in the box.  You install printers and configure 

ports using the Windows Control Panel.  

Orientation 

Choose Portrait or Landscape. 

Paper Size 

Select the size of paper that the document is to be printed on. 

Paper Source 

Some printers offer multiple trays for different paper sources.  Specify the tray here. 

Options 

Displays a dialog box where you can make additional choices about printing, specific to the type of 

printer you have selected. 

Network... 

Choose this button to connect to a network location, assigning it a new drive letter. 

 

 

 

File properties (File menu) 

 

Use this command to display the properties of the active file. This information includes the file size, 

recording time, number of channels etc. The comments stored using the Sound Format command as well 

as GPS data from a D500X/D1000X file (if present) are also displayed. 
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1, 2, 3, 4 command (File menu) 

 

Use the numbers and filenames listed at the bottom of the File menu to open the last four 

documents/sound files you closed.  Choose the number that corresponds with the document you want to 

open. 

 

 

 

Exit command (File menu) 

 

Use this command to end your BatSound session.  You can also use the Close command on the 

application Control menu.  BatSound prompts you to save documents (sound files) with unsaved 

changes. 

 

Shortcuts 

Mouse: Click the application's close button . 

  

Keys: ALT+F4 
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The Edit menu 

 

 

Undo/Can't Undo command (Edit menu) 

 

Use this command to reverse the last editing action, if possible.  The name of the command changes, 

depending on what the last action was.  The Undo command changes to Can't Undo on the menu if you 

cannot reverse your last action. 

 

Shortcuts 

 

Keys: CTRL+Z or 

 ALT-BACKSPACE  

 

 

 

Cut command (Edit menu)  

 

Use this command to cut the currently selected section of the sound file and put it on the clipboard. The 

length of the edited sound file is shorter than it was prior to editing. This command is unavailable if there 

is no data currently selected. 

 

Cutting data to the clipboard replaces the contents previously stored there. 

 

Shortcuts 

Toolbar:  

 

Keys: CTRL+X or 

 Shift + Delete 

 

 

 

Copy command (Edit menu)  

 

Use this command to copy the currently selected section of the sound file to the clipboard. Typically, you 

would use this function to edit the sound file or to create a new sound file.  

 

This command also makes a copy of the diagram in the active window. This is done independently of the 

copying of the sound file and puts a copy of the diagram on the clipboard. That way the diagrams can 

easily be pasted into other Windows applications (word processor, desktop publishing etc.). The 

clipboard will contain a copy of the diagram in two different formats; the bitmap and Windows Metafile 

formats. The application you paste the diagram into either picks the most suitable format or gives the 

user the option to select which format to use.  

 

Note that the bitmap format depends on the current graphics resolution of your system. With high 

resolution and many colors, the bitmaps can get very large. If so, you may find it worthwhile to reduce 

the number of colors prior to making the copy, or to use a graphics editor to reduce the number of colors 

of the picture file. The Windows clipboard editor and the application “Paint” have some basic picture 

file editing/conversion facilities.  

 

Note that some applications, e.g. Word for Windows, will choose the Metafile format if available, 

although this sometimes may change the aspect ratio of the diagram. If you encounter this problem, 

choose “Paste special” from the Edit menu to get the bitmap format instead.  
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If there is no data currently selected, this command only makes a copy of the diagram as described 

above. Copying data to the clipboard replaces the contents previously stored there. 

 

Note: To copy other diagrams than those in the main windows, e.g. a power spectrum, position the 

cursor in the power spectrum window and click the right mouse button to invoke a menu with the copy 

command. 

 

Shortcuts 

Toolbar:  

 

Keys: CTRL+C or 

 CTRL+Insert 

 

 

 

Copy Ascii command (Edit menu)  

 

Use this command to copy the sample values from the oscillogram to the clipboard. 

 

 

 

Paste command (Edit menu)  

 

Use this command to insert a copy of any sounds stored in the clipboard at the insertion point.  This 

command is unavailable if the clipboard is empty. 

 

Shortcuts 

Toolbar:  

 

Keys: CTRL+V 

 

 

 

Select All command (Edit menu)  

 

Use this command to select the entire document/sound file. This is useful when you wish to edit the 

entire document/sound file. 

 

 

 

Delete command (Edit menu)  

 

Use this command to cut the currently selected section of the document/sound file, without putting it on 

the clipboard. The length of the edited sound file is shorter than it was prior to editing. This command is 

unavailable if there is no data currently selected. 
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Clear/Silence command (Edit menu)  

 

Use this command to replace the currently selected section of the sound file with silence. The length of 

the sound file is the same as before using this command. This command is unavailable if there is no data 

currently selected. 

 

 

 

Reverse command (Edit menu)  

 

Use this command to time-reverse the currently selected section of the sound file. This command is 

unavailable if there is no data currently selected. 

 

 

 

Adjust Volume command (Edit menu)  

 

Use this command to increase or decrease the amplitude of the currently selected section of the sound 

file. This command is unavailable if there is no data currently selected. 

 

 

 

Filter command (Edit menu)  

 

Use this command to perform time domain filtering of the currently selected section of the sound file. 

Typically, you would use this command to remove or attenuate noise and other undesired artifacts of the 

signal. A theoretical, ideal filter would be able to completely remove certain frequencies from a signal as 

described below. However, all practical filters are only approximations of an ideal filter, so the desired 

frequencies are not completely removed but rather more or less attenuated.  

 

If you select the Filter command, the “Time domain filter” dialog appears, in which you can select the 

following filter characteristics: 

 

Lowpass Filter - removes/attenuates signals above the selected cut-off frequency (fc). 

Highpass Filter - removes/attenuates signals below the selected cut-off frequency (fc). 

Bandpass Filter - removes/attenuates signals below and above a selected band of frequencies 

(frequency limits fl and fu).  

Bandstop Filter - removes/attenuates signals within a selected band of frequencies (frequency limits fl 

and fu). 

 

For each of the above filters, you may also choose between Butterworth, Chebyshev type 1 or Elliptic 

filter types. For the User defined filter type, please see below.  

 

The Order of the filter determines the filter’s selectivity. A high order filter is more effective in 

attenuating the desired frequencies than a low order filter. You may select filter order 2, 4, 6 or 8.  

 

The Passband Ripple for Chebyshev type 1 and elliptic filters can be selected to 0.1, 0.2, 0.5, 1, 2 or 3 

dB. 

 

The maximum Stopband gain for the elliptic filter can be selected to -20, -30, -40, -50, -60 or -70 dB. 

 

After entering the desired filter specifications, you may also view the actual frequency response of the 

filter you just specified. This is a very useful feature, particularly for anyone with limited experience 

from filter design. To display the frequency response, click on the “Show Frequency Response” button.   
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If the User defined filter type is selected, the filter order and coefficients will be read from a text file 

("filter coefficient file"). This enables experienced users to design their own filters with characteristics 

other than the above mentioned. We suggest that users with no experience of digital filter design refrain 

from using the User defined filter type.  

With the User defined filter type, it is possible to implement transfer functions up to an order of 12, 

according to the following notation: 

 

             b0+b1z-1+b2z-2+ … +bnz-n 

 H(z) = ⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯ 

             a0+a1z-1+a2z-2+ … +anz-n 

 

The filter coefficient file can be created with any text editor capable of storing the text as a text file (no 

formatting), such as the Windows utility Notepad. The format for the filter coefficient file is: 

 
 filter order (n) 

 a0 

 a1 

 . 

 . 

 . 

 an 

 b0 

 b1 

 . 

 . 

 . 

 bn 

 

 

As an example, the filter coefficient file for a sixth order bandpass filter is: 

 
 6 

 1 

 0 

 1.7600 

 0 

 1.1829 

 0 

 0.2781 

 0.0181 

 0 

 -0.0543 

 0 

 0.0543 

 0 

 -0.0181 

 

 

 

Please refer to APPENDIX B for more information on filter design. 

 

 

 

Reset settings command (Edit menu) 

Use this command to reset various settings in BatSound to their default values. 
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The View menu 

 

 

Toolbar command (View menu) 

 

Use this command to display/hide the Toolbar, which includes buttons for some of the most common 

commands in BatSound, such as File Open.  A check mark appears next to the menu item when the 

Toolbar is displayed. 

 

See Toolbar for help on using the toolbar. 

 

 

 

Toolbar 

 

 
 

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar 

provides quick mouse access to many tools used in BatSound, 

 

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

 

The toolbar can be repositioned using the “drag and drop” technique. 

 

Click To 

 

 Open a new sound file for recording. 

 

 Open an existing sound file. BatSound displays the Open dialog box, in which you can 

locate and open the desired file. 

 

 Open the next file in the current folder in alphabetical order (relative to the active file). 

 

 Open the previous file in the current folder in alphabetical order (relative to the active file). 

 

 Save the active document/sound file or template with its current name.  If you have not 

named the document, BatSound displays the Save As dialog box. 

 

 Print the diagram in the active window. 

 

 Cut the currently selected section of the document/sound file and put it on the clipboard. 

 

 Copy the currently selected section of the document/sound file and put it on the clipboard. 

 

 Insert the contents of the clipboard at the insertion point. 
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 Display the About dialog box. 

 

 Set the mouse pointer in Context Help mode (the pointer will change to an arrow and 

question mark). Click on item to display help. 

 

 Display information on the installed Sound Device. 

 

 Start recording to selected file (optional display of real-time spectrogram/oscillogram). 

 

 Start playing sound from cursor position, or marked section. 

 

 Pause playing. 

 

 Stop playing. 

 

 Move cursor to beginning of file. 

 

 Move cursor to end of file. 

 

 Zoom in. 

 

 Zoom out. 

 

 Display oscillogram. 

 

 Display spectrogram. 

 

 Display oscillogram and spectrogram in the same window. 

 

 Display power spectrum. 

 

 Change default oscillogram parameter settings. 

 

 Change default spectrogram parameter settings. 

 

 Change default power spectrum parameter settings. 

 

 

 

Status Bar command (View menu) 

 

Use this command to display and hide the Status Bar, which describes the action to be executed by the 

selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 

the menu item when the Status Bar is displayed. 
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See Status Bar for help on using the status bar. 

 

Status Bar 

 

 
 

The status bar is displayed at the bottom of the BatSound window.  To display or hide the status bar, use 

the Status Bar command in the View menu. 

 

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 

through menus.  This area similarly shows messages that describe the actions of toolbar buttons as you 

depress them, before releasing them.  If after viewing the description of the toolbar button command you 

wish not to execute the command, then release the mouse button while the pointer is off the toolbar 

button. 

 

The right areas of the status bar indicate which of the following keys are latched down: 

 

Indicator Description 

CAP The Caps Lock key is latched down. 

NUM The Num Lock key is latched down. 

SCRL The Scroll Lock key is latched down. 

 



     BatSound 
®

    

  

47 

The Window menu 

 

 

Cascade command (Window menu) 

 

Use this command to arrange multiple opened windows in an overlapped fashion.  

 

 

 

Tile command (Window menu) 

 

Use this command to arrange multiple opened windows in a non-overlapped fashion. 

 

 

 

1, 2, ... command (Window menu) 

 

BatSound displays a list of currently open document/sound file windows at the bottom of the Window 

menu.  A check mark appears in front of the document name of the active window.  Choose a document 

from this list to make its window active.   
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The Sound menu 

 

 

Sound Devices command (Sound menu) 

 

Use this command to display information about the currently installed sound devices, and to select 

which of the available devices to use for sound playback/recording. 

 

 

 

Play Sound command (Sound menu) 

 

Use this command to play the currently selected section of the sound file. If nothing is selected, the 

sound file will be played from the current cursor position and to the end. 

 

Shortcuts 

Toolbar:  

 

Keys: P 

 

 

 

Move to beginning/end of file 

 

Use this command to move the cursor to the beginning/end of the file. This is useful to quickly scroll to 

the beginning or end of the file. 

 

Shortcuts 

Toolbar:   Move to beginning of file 

 

  Move to end of file 
 

 

 

Play Speed command (Sound menu)  

 

Use this command to select which speed to use for playback, 1/20, 1/10, 1/4, 1/2, 1, 2 or 4 times the 

original speed. Please note that using another replay speed than the original may result in a replay 

sampling frequency not supported by the sound card.  

 

When high sampling frequency sound files are used, the 1/2, 1/4, 1/10 and 1/20 alternatives can be used 

to obtain time expansion of the high frequency sound. 

 

 

 

Record Sound command (Sound menu) 

 

Use this command to start recording to the selected file. As the recording is started, the Recording status 

dialog box appears on the screen. If the Real time graphics check box is checked, the oscillogram and/or 

spectrogram is displayed at the same time the signal is stored on the hard disk, using the settings in the 

Spectrogram Settings dialog box (see Spectrogram Settings command in the Analysis menu). To select 
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what to view during recording (oscillogram, spectrogram or both), click on the desired diagram type in 

the toolbar before starting the recording. 

 

To stop/pause the recording, click the Stop button in the Recording Status dialog box. Here you can also 

clear the current file and start recording to a new file. To exit the current recording session, click the Exit 

button. 

 

Unless a new file has been selected (New command in the File menu) the recording will be appended to 

the file in the current active window, using the Sound Format settings of the current file. 

 

If the recording is made to a new file, the sampling frequency and number of bits selected with the 

Sound Format command (Sound menu) will be used. The default file format is BatSound Wave. 

 

Shortcuts 

Toolbar:  

 

Keys: R 

 

 

 

Pause Play Sound command (Sound menu)  

 

Use this command to pause playing. To resume playing, select Play Sound. The difference between the 

Stop Play Sound and Pause Play Sound commands is that the former resets the cursor to the beginning of 

the file while the latter does not. 

 

 

Shortcuts 

Toolbar:  

 

 



     BatSound 
®

    

  

50 

 

 

Stop Play Sound command (Sound menu)  

 

Use this command to interrupt playing. 

 

Shortcuts 

Toolbar:  

 

Keys: S 

 

 

 

Sound Format command (Sound menu)  

 

Use this command to select the sound format to be used to make a recording.  

 

Number of bits : 8, 16, 24 or 32 

 

Number of channels : 1 or 2 (mono or stereo) 

 

Sampling frequency : 44100 Hz, 48000 Hz, 96000 Hz, 192000 Hz, 256000 Hz, 384000 Hz or user 

defined. 

 

Please note that if you select “user defined”, not all sampling frequencies may be allowed on all sound 

cards, so the actual sampling frequency may differ from that you enter. Normally the sound card informs 

the program about the actual sampling frequency, and this will be displayed at the lower right of the 

screen. However, some sound cards erroneously claim to be working with the desired sampling 

frequency, although the actual sampling frequency may differ from this. In such case, the program will 

not display the correct time and frequency information. 

 

Time expansion factor: A signal that is time expanded 10 times (e.g. with a bat detector) will appear to 

have a frequency one tenth of what it originally was. The time scale also will be 10 times longer. In order 

to automatically compensate for this, enter the time expansion factor (in this case: 10), and all time and 

frequency axes will be changed accordingly. If a time expansion factor of 1 is entered, no changes will 

be made to the axis scaling. 

 

Any time expansion factor entered in the Sound Format dialog box before a new recording is made 

(default: 1) is stored in the sound file provided that the file was stored in “BatSound Wave” format. The 

time expansion factor is automatically retrieved when a file in BatSound Wave format is loaded. 

 

In the Comments field of the sound format dialog, you may enter any information you find suitable to 

identify the recording (e.g. recording location, date and time). This information is stored in the sound 

file and is automatically retrieved upon loading a file, if the BatSound Wave format was used to save the 

file. 

 

 

Which sampling frequency should I choose? 

 

The highest possible signal frequency is roughly half the sampling frequency, so sampling with 44100 

Hz makes it possible to analyze signals up to 22050 Hz, theoretically. In practice, the upper frequency 

limit will be less than half the sampling frequency, in this case perhaps around 20000 Hz. So, if you 

know the frequency content of the signal you want to analyze, you can select the sampling frequency 

accordingly.   
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Automatic recording command (Sound menu)  

 

Selecting this command, opens the Automatic Recording dialog box from which the Automatic 

recording mode can be selected. 

 

The Automatic recording mode is similar to a voice activated tape recorder – a sufficiently strong sound 

will make the program start recording. When the sound level is low again, the recording is stopped. The 

actual sound level that determines the start/stop of the recording is user selected. 

 

The main parameter that determines when to start a recording is the sound level. When the sound level is 

above a certain threshold, the automatic recording system is said to be triggered – and the recording 

starts. There are two triggering modes, from the amplitude in an oscillogram or from the levels over a 

selected range of frequencies in a power spectrum. 

 

When the Oscillogram level trigger type is selected, the system is triggered when the sound level 

exceeds the level entered in the Oscillogram threshold box. This level can be entered either as a dB 

value or a percentage of the full range. 0 dB corresponds to 100%, -6 dB to 50%, etc. 

 

When the Frequency domain level trigger type is selected, power spectra are continuously calculated 

and evaluated. The system will be triggered when the power spectrum level exceeds the dB value 

entered in the Power spectrum threshold box at any frequency over the frequency range determined by 

the Lower frequency limit and Upper frequency limit, i.e. a frequency-selective triggering is 

obtained. That way, it is possible to stop the automatic recording system to from being triggered by 

signals outside the ‘interesting’ frequency range (e.g. by low-frequency noise). The FFT size, FFT 

overlap and FFT window has the same function as in the spectrograms. Please refer to the Spectrogram 

Settings command in the Analysis menu or Appendix A (The basics of signal processing) for more 

information about these parameters.  

 

If the selected sound format is stereo, it is also possible to select left, right or both channels as Trigger 

source. 

 

Once a valid trigger has been detected, the General recording parameters determine exactly when the 

recording will be started. The Recording time before trigger determines how long before the trigger 

occurred the recording should start. That way, cutting off the start of a sound pulse can be avoided. A 

memory buffer is used to make it possible to start recording before the trigger. In a similar way, the 

recording can be allowed to continue a short time after the triggering conditions are no longer valid 

(Recording time after trigger). 

 

To avoid rapidly filling up the hard disk, the maximum recording time per file (Max. recording time 

per file), as well as the number of recordings per session can be limited (Max. number of recordings).  

 

The Minimum duration determines the required length of a signal in order for a recording to start. That 

way, false triggering from single, short pulses can be avoided. 

 

The recordings can be made either sequentially in a single file or each recording in a separate file. This is 

selected in the box File numbering, in which also the file name ending can be chosen (a sequential 

number, date and number, date and time or time). This makes it easy to determine the time each 

recording was made. The file beginning should be entered in the File names – beginning field.  

 

In addition to this, it is also possible to automatically have marks added at the start of each recording. 

This is particularly useful if you are recording to a single file. This feature is enabled in the Mark start 

of recording box, where different options to display at each mark are available.   
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Virtual Bat Detector command (Sound menu)  

 

Selecting this command toggles between the normal mode and the Virtual Bat Detector mode. In the 

Virtual Bat Detector mode, time expanded (or high-speed recorded) sounds are replayed at their original 

speed, as heard through a heterodyne bat detector. Please refer to chapter 7 for detailed information on 

the Virtual Bat Detector mode. 

 

To exit the Virtual Bat Detector mode, select this command a second time in the Sound menu. A check 

mark to the left of the command indicates that the Virtual Bat detector mode is active. 
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The Tools menu 

 

 

Zoom In command (Tools menu) 

 

Use this command to zoom in on a certain section of the signal. The section to be zoomed should first be 

selected. If no selection is made, the next higher standard zoom level will be chosen. 

 

If you wish to zoom only along the time axis (i.e. change the time interval to be displayed), the Marking 

Cursor should be used.  

 

Using the Measurement Cursor enables you to select a “window” in the diagram to be zoomed (i.e. zoom 

along both axes). This is possible in both the oscillogram and the spectrogram. 

 

Please note that it is possible to unintentionally make a very narrow selection (the marked interval may 

then look almost like the vertical cursor). The subsequent commands may then give unexpected results, 

e.g. choosing Zoom In will cause an extremely small portion of the sound file to be displayed. 

 

Note: Making two or more rapid clicks on the Zoom button will change the zoom level more than one 

step. This can be used to inhibit the program from redrawing the diagram for each zoom level (in the 

case of a high-resolution spectrogram, this may take some time!).   

 

It is also possible to manually enter figures for the time, amplitude and frequency scales in the 

Oscillogram Settings and Spectrogram Settings dialogs. 

 

Shortcuts 

Toolbar:  

 

Keys: Ctrl Up-arrow 

 

 

 

Zoom Out command (Tools menu)  

 

Use this command to go back to the previous zoom level. 

 

Shortcuts 

Toolbar:  

 

Keys: Ctrl+Down-arrow 

 

 

 

Default Zoom command (Tools menu)  

 

Use this command to restore the display to the original zoom level (which was used when the window 

was opened). 

 

Shortcuts 

 

Keys: Ctrl+Shift+Left-arrow 
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Zoom Entire File command (Tools menu)  

 

Use this command to adjust the zoom level to show the full length of the signal. 

 

Shortcuts 

 

Keys: Ctrl+Shift+Down-arrow 

 

 

 

Zoom full range frequency/amplitude (Tools menu) 

 

Use this command to adjust the vertical zoom level so that the full frequency and amplitude range is 

shown in the spectrogram and oscillogram. 

 

 

 

Marking Cursor command (Tools menu)  

 

Use this command to select the Marking type cursor. Using this cursor type you can select (mark) 

desired section of the signal for editing, playing etc. In order to select a section of the sound file, position 

the pointer at the start point of the desired section and press the left mouse button. Hold the button down, 

move the pointer to the desired end position, and then release the button. The selected section will be 

shown in inverted colors, and the time data for the selected interval will be shown above the scrollbar. 

 

When used to mark a section to be zoomed, the zooming action is made only along the time axis. 

 

Please note that it is possible to unintentionally make a very narrow selection (the marked interval may 

then look almost like the vertical cursor). The following commands may then give unexpected results, 

e.g. choosing Zoom in will cause an extremely small portion of the sound file to be displayed. 

 

Clicking the right mouse button somewhere in the active window will invoke a menu containing this 

command. This enables you to quickly change between the two cursor types. 

 

Shortcuts 

  

 Keys: Ctrl+A 

 

 

 

Marking Cursor - stereo command (Tools menu)  

 

This command is identical to the Marking Cursor command, except that the Marking Cursor - stereo 

command is used to select the same time interval on both channels of a stereo file. 

 

 

 

Measurement Cursor/Large Measurement Cursor commands  (Tools menu)  

 

Use these commands to select the Measurement type cursor. Using this cursor type the X and Y 

coordinates at the cursor position is displayed above the scrollbar. Clicking the left mouse button 

activates a second cursor while freezing the first cursor. This enables measurements of differences in X 
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and Y coordinates. This cursor type is also used to mark a section to be zoomed along both the vertical 

and horizontal axes. 

 

In order to fine tune the position of the cursor, the arrow keys on the keyboard may be used. 

 

Clicking the right mouse button somewhere in the active window will invoke a menu containing this 

command. This enables you to quickly change between the two cursor types. 

 

Shortcuts 

  

 Keys: Ctrl+Shift+A (Measurement cursor) 

 

 

 

Level Cursor command (Tools menu)  

 

Use this command to select the Level type cursor. This cursor type is used in the Pulse Interval and Pulse 

Length analyses to set the threshold level in the oscillogram. Position the cursor with the mouse and 

click the left button to select a new level. 

 

 

 

Save cursor as mark command (Tools menu)  

 

Use this command to put a "mark" at the current cursor position. A mark is an object that may be located 

anywhere in the diagrams. It may be used to measure a number of "X-Y distances" in the diagrams, to 

scroll to any of the marks, or to annotate text in the diagrams. 

 

 

 

The appearance of the mark depends on the type of cursor you used when saving the cursor as a mark. 



     BatSound 
®

    

  

56 

The marks are saved in the file, provided the "Wave (BatSound)" format is used.  

 

This command is also available from the "right-hand mouse button menu".   

 

 

 

Set active mark command (Tools menu)  

 

Use this command to select the "active mark". Only one mark can be active at each time. The active 

mark may be moved and its properties may be changed. 

 

 

 

Active mark properties command (Tools menu)  

 

 

Use this command to change the properties of the active mark. The label and type of mark can be 

selected. It is also possible to hide the label and/or mark by unchecking the respective box. If desired, 

comments may be entered in the "Description" field. 

 

Clicking the "Remove" button will erase the active mark. 

 

 

 

Move active mark command (Tools menu)  

 

Use this command to activate the "mark move" mode. Using the arrow keys, you may adjust the position 

of the active mark.   

 

To exit this mode, select the Move active mark command a second time. 

 

 

 

Mark distances command (Tools menu)  

 

Use this command to display a table showing the differences between the X and Y coordinates of all 

marks. 
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Scroll to mark command (Tools menu)  

 

Use this command to scroll to one of the available marks. This feature is particularly useful to quickly 

move between different parts of a long file. 

 

 

 

Clear all marks command (Tools menu)  

  

Use this command to delete all marks in the active sound file. Marks can be selectively deleted by 

selecting “Remove” in the Mark Properties dialog. 

 

The Analysis menu 

 

 

Spectrogram command (Analysis menu)  

 

Use this command to display the spectrogram of a signal. An oscillogram or spectrogram has to be 

present in the active window before you choose this command. The spectrogram of the section displayed 

in the active window will be calculated and displayed in a new window, using the parameters given in 

Spectrogram Settings. If you have selected a section of the signal in the active window, the spectrogram 

of that section will be displayed. 

 

Spectrogram “right mouse button menu” 

 

If you click the right mouse button somewhere in the Spectrogram window, a menu with a number of 

commonly used commands will appear. The commands are: 

 

Cut, Copy, Paste, Save cursor as mark, Spectrogram Settings (refer to the Edit, Tools and Analysis 

menus for detailed information on these). 

 

Entering new values in the Spectrogram Settings dialog will only affect the current diagram, as opposed 

to the Spectrogram Settings – Default command in the Analysis menu, which affects all Spectrograms 

drawn subsequently.  

 

The cursor type (Marking cursor, Measurement cursor etc.) can also be chosen in this menu. 

 

 

Shortcuts 

  

 Toolbar:  

 Keys: Ctrl+Shift+S 

 

 

 

Oscillogram command (Analysis menu) 

 

Use this command to open a new window and display the oscillogram of the signal in the current active 

window. 

 

 

Oscillogram “right mouse button menu” 
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If you click the right mouse button somewhere in the Oscillogram window, a menu with a number of 

commonly used commands will appear. The commands are: 

 

Cut, Copy, Paste, Save cursor as mark, Oscillogram Settings (refer to the Edit, Tools and Analysis 

menus for detailed information on these) and Copy Ascii. 

 

The Copy Ascii command copies the raw sample values to the Windows clipboard, to enable exporting 

these to other applications. 

 

Entering new values in the Oscillogram Settings dialog will only affect the current diagram, as opposed 

to the Oscillogram Settings – Default command in the Analysis menu, which affects all Oscillograms 

drawn subsequently. 

 

The cursor type (Marking cursor, Measurement cursor etc.) can also be chosen in this menu. 

 

Shortcuts 

  

 Toolbar:  

 Keys: Ctrl+Shift+O 

 

 

 

Combined command (Analysis menu)  

 

Use this command to open a new window and display both the oscillogram and spectrogram of a signal 

in the same window. See also Spectrogram command. 

 

 

Shortcuts 

  

 Toolbar:  

 

 

 

Power Spectrum command (Analysis menu) 

 

Use this command to display the power spectrum of the signal in the active window. The power 

spectrum window may be resized by dragging the size bars at the corners or edges of the window, or by 

clicking the maximize button in the title bar of the power spectrum window.  

 

The power spectrum can be calculated in two ways: 

 

1. Mark the starting point of the interval over which you wish to calculate the power spectrum. The FFT 

size given under Power Spectrum Settings determines the length of the interval, which is shown in 

inverse colors.  

 

or 

 

2. Mark the desired time interval over which you wish to calculate the power spectrum. A number of 

FFTs are calculated over this interval, and then averaged before being displayed. A small overlap 

between successive FFTs will be used to fit the FFTs into the desired time interval. 
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The time interval over which the power spectrum is calculated is displayed in the lower right corner of 

the diagram. 

 

It is also possible to display the power spectrum in the continuous update mode, meaning that the 

power spectrum is continuously updated as the time interval/starting point is changed. This is 

particularly useful for examining how the power spectrum changes while scrolling through a 

spectrogram (use the arrow keys to move the cursor through the spectrogram). Note that the actual 

interval over which the power spectrum is calculated is always shown.  

 

Power Spectrum “right mouse button menu” 

 

If you click the right mouse button somewhere in the Power Spectrum window, a menu will appear from 

which you may print the diagram, copy the diagram to the clipboard or change the Power Spectrum 

settings of the diagram in the active Power Spectrum window.  

 

The Settings – current diagram command allows you to use a different window, FFT size or power scale 

(please refer to Power Spectrum Settings command for more information on this). Please note that the 

Settings command in this menu only affects the current diagram, while the Power Spectrum Settings - 

Default command in the Analysis menu affects all diagrams made subsequently. 

 

The Copy command will copy the Power Spectrum to the clipboard, so you can paste it into other 

Windows applications. 

 

The Copy Ascii command copies the N/2 values in the Power Spectrum (N = FFT size) to the Windows 

clipboard. The values are stored as pairs of numbers (frequency and power spectrum value). This is 

useful to export the Power Spectrum data to e.g. a spreadsheet program. 

 

The Print command will print the Power Spectrum on the printer. Please note that the Print command in 

the File menu will only print the oscillogram and/or spectrogram of the signal. 

 

The Logarithmic Scale command is used to toggle between logarithmic (dB) and linear scale (V2) on the 

vertical axis. This can also be made in the Settings dialog box (see above). 

 

The Continuous Update command is used to enable/disable the continuous update mode. This can also 

be done in the Settings dialog box (see above). 

 

The Ascii File Export command saves the N/2 (N = FFT size) values in the Power Spectrum in a text file. 

The values are stored as pairs of numbers (frequency and power spectrum value). See also the Copy 

Ascii command. 

 

  

Shortcuts 

  

 Toolbar:  

 Keys: Ctrl+Shift+P 

 

 

 

Pulse Interval and Pulse Length Analysis commands (Analysis menu)  

 

These two analysis types both result in a histogram showing the distribution of the time intervals 

between successive pulses (the Pulse Interval) and pulse lengths respectively. 
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To make this analysis, make sure the active window contains an oscillogram of the signal you want to 

analyze. Using the mouse, select the desired time interval for the analysis. When you choose Pulse Train 

Analysis from the Analysis menu, two horizontal cursors appear in the oscillogram. Using the mouse, 

adjust the cursors slightly above the noise floor and check that the cursors intersect all pulses you want 

to include in the analysis (only pulses exceeding the cursor level will be counted). The number of 

pulses/pulse intervals detected and the time interval over which the analysis is made will be shown in the 

lower right corner of the diagram. 

 

In order to enable automated analysis of pulse length and pulse interval a so-called Detection Delay is 

used. The detection delay is used in two ways: 

 

1.  The pulse level is allowed to go below the cursor threshold for a maximum time equal to the 

detection delay without causing the analysis algorithm to interpret this as two separate pulses. 

2.  The pulse level is required to remain below the cursor threshold for at least the detection delay time 

(counted from the time instant it last crossed the cursor threshold) in order to qualify for a detection 

of the pulse end. 

 

The Detection Delay should be chosen less than the expected pulse lengths. If too large a value is 

entered, the analysis algorithm will not recognize all pulses. 

 

In the Pulse Interval/Pulse Length Settings dialog, you may also adjust the time scale for the histograms. 

 

Pulse Interval/Pulse Length analysis “right mouse button menu” 

 

If you click the right mouse button somewhere in the Pulse Interval/Pulse Length window, a menu will 

appear from which you may print the diagram, copy the diagram to the clipboard or change the Pulse 

Interval/Pulse Length settings of the diagram in the active Pulse Interval/Pulse Length window.  

 

The Settings – current diagram command allows you to change the settings for the current histogram. 

The settings you enter in the Pulse Interval/Pulse Length Settings – Default dialog box (from the 

Analysis menu) are the default settings used for all Pulse Interval/Pulse Length analyses made 

subsequently.  

 

The Copy command will copy the histogram to the clipboard, so you can paste it into other Windows 

applications. 

 

The Copy Ascii command copies the histogram analysis data to the Windows clipboard. The values are 

stored as triplets of numbers (the time interval given as “From (ms)”, “To (ms)” and the number of 

observations in that interval). This is useful to export the data to e.g. a spreadsheet program. 

 

The Print command will print the histogram on the printer. Please note that the Print command in the 

File menu will only print the oscillogram and/or spectrogram of the signal. 

 

The Continuous Update command, is used to enable/disable the continuous update mode. This can also 

be done in the Settings dialog box (see above). 

 

The Automatic Settings command enables/disables this mode (see the Pulse Interval/Pulse Length 

Settings command). 

  

 

 

Pulse Feature Analysis command (Analysis menu)  

 

Use this command to automatically extract information on: 
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Pulse duration 

Pulse start time 

Pulse end time 

Maximum frequency 

Minimum frequency 

Bandwidth 

Frequency of maximum energy (FME) 

Maximum amplitude 

 

There are two different commands for this feature, one for running the analysis on a set of multiple files 

and one for running it on the currently active file in BatSound. 

 

The analysis data is displayed in a table and can also be copied to the Windows clipboard, as well as 

exported to an HTML file. 

 

The following analysis parameters can be selected: 

 

Fixed threshold – Enter the desired threshold in dB. Only pulses exceeding this level will be analyzed.  

 

Minimum separation – In a similar fashion to the Frequency separation parameter, this parameter will 

filter out signals that are too close in time to a previous signal. 

 

Time gap – In order to avoid interpreting a pulse with varying amplitude as several pulses, enter a 

number for the expected minimum separation between pulses in ms. If the amplitude falls below the 

threshold and once again reaches above the threshold before the “Minimum separation” has passed, the 

program will consider this to be only one pulse. 

 

Minimum duration – Enter the desired value in ms. Only pulses with a duration at least this value, will 

be analyzed. 

 

Maximum duration – Enter the desired value in ms. Only pulses with a duration that do not exceed this 

value, will be analyzed. 

 

Spectrogram threshold – Once a pulse fulfilling the above criteria has been found, the spectrogram is 

analyzed. When the algorithm searches for the minimum and maximum frequencies, the “Spectrogram 

threshold” value is used. Entering a value of e.g. –40 dB means that the min/max frequency will be the 

lowest/highest frequency where the amplitude still is above –40 dB.   

 

Frequency gap – When searching for min/max frequency, the algorithm allows this gap in frequency 

and still considers it a continuous pulse. To disable this function, enter “0”. 

 

Frequency separation – This parameter sets the minimum frequency value that is allowed between two 

different pulses. A signal that is separated from another signal with less than the entered value will be 

filtered out.  

 

Lower/Upper frequency limit – Frequencies below/above these limits will be excluded from the 

analysis. Useful to avoid low- and/or high-frequency noise to affect the analysis. To disable either limit, 

enter “0”. 
 

Threshold Add – This value will be added to the calculated threshold. 

 

Threshold Min – This value sets the lower bound for the threshold. 

 

Freq dependence (%) – When the frequency dependent threshold is active, it will be weighted with this 

value to make it more or less frequency dependent. 
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% max – The calculated mean amplitude for each frequency is weighted with the maximum value for 

each frequency. A high percentage will set the threshold closer to the maximum value. 
 

Pulse measurements – Checking the respective boxes will make the corresponding parameter to be 

calculated and displayed in the results table.  

 

The “Mark...” boxes are used to enable automatic positioning of marks at the respective locations in the 

oscillogram and spectrogram. It is recommended to enable this feature, since this makes it easy to see 

which start/end time, min/max frequency the program has found. For clarity, the mark labels are not 

visible in this case. Each mark has a label though (shown e.g. in the “Set Active Mark” list). If desired, 

the labels can manually be made visible in the Active Mark Properties dialog. 
 

 

Before making a second analysis of the same file, it is usually advisable to delete the marks from the 

previous analysis using the Clear Marks button. To delete all marks, use the Clear All Marks command 

in the Tools menu.  

 

Note: As with all automatic measurements, there is always a chance that the program will 

interpret the signal differently than if it was manually analyzed. It is recommended that you 

enable the “marks positioning” feature and that you study the location of the marks after making 

the analysis. This will make it easy to identify any unexpected results.  

 

 

 

Spectrogram Settings - Default command (Analysis menu)  

 

Use this command to change the Spectrogram analysis parameters for any subsequent analyses. If you 

wish to change the settings only for the currently displayed spectrogram, use the “Spectrogram Settings 

– current diagram” command instead, available in the “Spectrogram right mouse button menu”. To 

access this menu, position the cursor in the spectrogram area and press the right mouse button. 

 

The parameters are: 

 

FFT size - the number of samples used for each FFT. You may select one of the following FFT sizes: 

 

 16, 32, 64, 128, 256, 512, 1024, 2048 or Automatic. 

 

The frequency resolution will be higher (but the time resolution lower!), the larger number of samples 

you choose. If you choose “Automatic”, the program will select an FFT size giving a resolution that 

approximately corresponds to the actual screen resolution with the current window size. 

 

FFT Window - the window type used for the FFT. You may select one of the following windows: 

 

Rectangular, Hanning, Hamming, Parzen or Cosine. 

 

The Hanning window is a commonly used general-purpose window. Different windows have different 

properties regarding spectral leakage and frequency resolution. For more information about this, please 

refer to Appendix A of this manual or the extensive selection of literature on digital signal processing. 

 

FFT Overlap - the overlap in % of the FFT window between successive FFTs. An overlap of 50 % 

means that the “next” FFT will start in the middle of the interval used to calculate the “current” FFT. A 

large overlap increases the computation time for the spectrogram, but results in a smoother curve 

(“higher time resolution”). If the “Automatic” check box is checked, the program will select a suitable 

overlap, corresponding to the present window size and time scale. If the time scale is such that a very 
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long portion of the signal is displayed in the window, the program will adjust the overlap to avoid long 

calculation times. If short pulses are present in the window in this case, some of these may be lost in the 

spectrogram. To avoid this situation, manually select a sufficient overlap in such cases. 

 

Milliseconds per plot - determines the time scale. Enter the desired number of milliseconds to be 

displayed in the window. 

 

Note: In the real-time spectrogram mode, only values between 2000 and 30000 (i.e. 2 and 30 seconds) 

will be accepted. The value will also be truncated to the nearest integer number of seconds. 

 

Min and max frequency - determines the frequency scale. Enter the desired frequency range to be 

displayed. 

 

Color mapping - select one of the available mappings of power spectrum levels into different colors. 

 

Amplitude contrast - select one of the available contrast curves. This is useful to emphasize differences 

in the power spectra levels for certain level intervals.  

 

This function is not active with user defined color mappings. 

 

Threshold - adjust the level threshold in the power spectra. Portions of the power spectra below the 

threshold will not be displayed in the spectrogram. A weak signal requires a lower threshold, while a 

strong signal is likely to look best with a higher threshold. 

 

This function is not active with user defined color mappings. 

 

Show amplitude color bar - check this box to display a color bar in the spectrogram window, showing 

the actual mapping of different levels (dB) into colors.  

 

Low level de-emphasis - check this box to change the color mapping so that the low-level portions of 

the spectrogram will be shown in less bright colors. 

 

Channel to view - select which channel to view in the case of a stereo recording; left, right or both.   

 

Grid lines – select the number of grid lines per tick mark on the vertical and horizontal axes, or no grid 

lines. 

 

Values at all tick marks – check this box to obtain values at all tick marks on the frequency axis. 

 

The frequency resolution and the time between FFTs (“time resolution”) resulting from the chosen 

parameters are calculated and displayed, if FFT size and overlap are chosen manually. 

 

If you want to update the active spectrogram with the new settings, click the Apply button before 

closing the dialog box. Changing the settings for the active spectrogram only can be accomplished from 

the “right mouse button” menu. 

 

 

User defined color mappings 

 

In addition to the predefined color mappings, the user can design any desired color mapping. Click the 

“User colors” button to enter the color mapping design mode. Choose “New” in the “User defined color 

mappings” dialog to open the “Spectrogram color mapping” dialog. Here you can enter the desired 

colors for the different dB intervals. 
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Each interval has its corresponding “from” and “to” color. First, choose the dB interval by entering the 

“From (dB)” and “To (dB)” values. Then enter the number of colors that should be used over the 

selected interval (“Count”) or the “Step” size in dB within the interval. Obviously, these four parameters 

interact, and the program will automatically update the other parameters if one of them has been 

changed. The colors corresponding to the “From” and “To” dB values should also be chosen. Click on 

the “From” and “To” buttons under “Specify colors” and pick the desired colors. Repeat this procedure 

for any number of intervals you wish up to 64.  

 

Example. Assume you want to design a color mapping with the following colors. For all levels from 0 

dB to –10 dB, the color should be black. From –10 dB to –20 dB the color should change gradually from 

black to gray and from –20 to –60 dB the color should change from gray to light yellow in 5 dB steps. 

 

Entering the values as shown below will give the desired mapping: 

 

 

 Note that the “Count” value for the first interval is 1, to ensure that only one color is used there. The 

“Step” value for the second interval was chosen to 0.2 dB to give a smooth transition between the two 

colors (black and gray). 

 

To save the color mapping, enter a name (“Example mapping” in the example) and click “Save”. After 

saving it, this color mapping will be available as one of the alternatives under Amplitude Color Mapping 

in the Spectrogram Settings dialog. 

 

If you wish to transfer your color mapping to another computer, it is possible to do so with the 

Import/Export feature. This allows you to store the color mapping as a file. 

 

 

Shortcut 

 

Toolbar:  

 

 

 

Oscillogram Settings - Default command (Analysis menu)  

 

Use this command to change the Oscillogram display parameters for any oscillograms to be shown. 

 

These parameters are: 
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Milliseconds per plot - determines the time scale. Enter the desired number of milliseconds to be 

displayed in the window. 

 

Note: In the real-time spectrogram mode, only values between 2000 and 30000 (i.e. 2 and 30 seconds) 

will be accepted. The value will also be truncated to the nearest integer number of seconds. 

 

Channel to view - select which channel to view in the case of a stereo recording, left, right or both. 

 

Relative height to spectrogram - determines the relative sizes of the oscillogram and the spectrogram. 

A small value corresponds to a smaller oscillogram and larger spectrogram, and vice versa for a large 

value. 

 

Min and Max Amplitude - determines the amplitude scale. Enter numbers between –100 and 100 (%). 

 

Line between samples – Check this box if you wish to have lines drawn between successive samples 

(improves appearance of the oscillogram at high zoom levels). 

 

Grid lines – select the number of grid lines per tick mark on the vertical and horizontal axes, or no grid 

lines. 

 

If you want to update the active diagram with the new settings, click the Apply button before closing the 

dialog box. Changing the settings for the active diagram only can be accomplished from the “right 

mouse button” menu. 

 
 

 

Power Spectrum Settings - Default command (Analysis menu)  

 

Use this command to adjust the Power Spectrum analysis parameters for any subsequent analyses. 

 

The parameters are: 

 

FFT size  - the number of samples used for each FFT. You may select one of the following FFT sizes: 

 

 16, 32, 64, 128, 256, 512, 1024, 2048, 4096, 8192, 16384 or Automatic. 

 

The frequency resolution will be higher, the larger number of samples you choose. The choice 

“Automatic” will result in a variable FFT size, depending on the size of the window. 

 

FFT Window  - the window type used for the FFT. You may select one of the following windows: 

 

Rectangular, Hanning, Hamming, Parzen or Cosine. 

 

The Hanning window is a commonly used general-purpose window for stationary signals. However, for 

signals of limited duration (such as bat calls), the rectangular window usually is a better choice if the 

FFT size can be chosen to make one FFT exactly cover the limited duration signal. For more information 

on this, please refer to Appendix A of this manual or the extensive selection of literature on digital signal 

processing. 

 

FFT Overlap. The interval for calculating an FFT can be determined either by the FFT size only (by just 

clicking at the desired start point in the spectrogram or oscillogram) or by highlighting a (longer) time 

interval and then selecting the Power Spectrum command. In the latter case, a number of FFTs will be 

calculated along the marked time interval and then averaged. The FFT Overlap in percent can be 

selected in the settings dialog. An overlap of 50% means that the "next" FFT will start at the time 
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corresponding to the middle of the current FFT. Usually, a larger overlap gives a better result. An 

overlap value between 0 and 98% can be entered. 

 

The actual FFT calculation interval depends on both the FFT size and the FFT overlap and obviously, if 

a certain time interval is marked for the calculation of the FFTs, it may be impossible to obtain exactly 

this time interval with the selected FFT size and FFT overlap. If the Justify overlap box is un-checked, 

a slightly different calculation interval will be used (than the interval that is actually marked). On the 

other hand, if the Justify overlap box is checked, the overlap will be adjusted instead, and the calculation 

interval will be exactly the one marked on the screen. The actual FFT overlap is then displayed in the 

FFT title bar. In both cases, using a large overlap gives a smaller deviation from the desired calculation 

interval and overlap, respectively. 

 

Min level, Max level - determines the scaling of the vertical axis, i.e. the level span in dB or V2 to be 

shown. 

 

Min freq, Max freq - determines the scaling of the horizontal axis, i.e. the frequency span to be 

displayed. 

 

Continuous update - check this box to activate the continuous update mode. In this mode, the power 

spectrum will instantaneously follow any changes made to the cursor position in the oscillogram (or 

spectrogram).  

 

Logarithmic scale - check this box to activate logarithmic power scale (dB). Leaving the box 

unchecked gives a linear power scale (V2). 

 

Note: The Power Spectrum Settings dialog box can also be reached from the Power Spectrum window, 

by clicking the right mouse button and then selecting “Settings - Current diagram” from the menu. This 

is useful if you want to make changes to the settings of the analysis you just made. Changes of the 

power spectrum settings made from the “right mouse button menu” only apply to that particular 

power spectrum, while changes made through the Power Spectrum Settings - Default command in 

the Analysis menu are the default values that apply to all power spectra made subsequently.   

 

 

Shortcuts 

  

 Toolbar:  

  

 

 

Pulse Interval/Pulse Length Settings - Default command (Analysis menu)  

 

Use this command to change the Pulse Interval/Pulse Length analysis parameters for any subsequent 

analyses. 

 

The parameters you can adjust are: 

 

Detection Delay Time - The detection delay is used in two ways: 

 

1. The pulse level is allowed to go below the cursor threshold for a maximum time equal to the detection 

delay without causing the analysis algorithm to interpret this as two separate pulses. 

 

2. The pulse level is required to remain below the cursor threshold for at least the detection delay time 

(counted from the time instant it last crossed the cursor threshold) in order to qualify for a detection of 

the pulse end. 
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The Detection Delay should be chosen less than the expected pulse lengths. If too large a value is 

entered, the analysis algorithm will not recognize all pulses. 

 

Histogram start time - the start value in seconds for the time scale of the respective histogram. 

 

Histogram end time - the end value in seconds for the time scale of the respective histogram. 

 

Numbers of histogram bars - determines the width of each bar. 

 

Detection Threshold - the threshold you set with the horizontal cursors, expressed in % of the 

maximum signal amplitude. You may change this either by entering a new value here or by changing the 

cursor level. 

 

All parameters except the Detection Delay Time can also be calculated automatically if the “Automatic 

Calculation…” box is checked. The program then attempts to select suitable values depending on the 

actual signal and to adapt the time scale so that all bars in the histogram will be displayed.  

 

Checking the “Continuous Update” box will cause the histogram to be updated immediately upon 

making any change in the selected interval of the signal. 

 

Note: The Pulse Interval/Pulse Length Analysis Settings dialog box can also be reached from the Pulse 

Interval/Pulse Length window, by clicking the right mouse button and then selecting “Settings - Current 

diagram” from the menu. This is useful if you want to make changes to the settings of the analysis you 

just made. Changes of the Pulse Interval/Pulse Length Analysis settings made from the “right mouse 

button menu” only apply to that particular Pulse Interval/Pulse Length diagram, while changes 

made through the Pulse Interval/Pulse Length Analysis Settings – Default command in the Analysis 

menu are the default values that apply to all Pulse Interval/Pulse Length diagrams made 

subsequently.   
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The Help menu 

 

 

Help command (Help menu) 

 

Use this command to open the BatSound User’s Manual as a pdf file. 

 

Shortcut 

 

 Keys: F1 

 

 

Help on the Web (Help menu) 

 

Use this command to open the Help page at the Pettersson web site in your browser. 

 

 

Pettersson Homepage (Help menu) 

 

Use this command to open the main page at the Pettersson web site in your browser. 

 

 

 

About command (Help menu) 

 

Use this command to display the copyright notice and version number of your copy of BatSound. 

 

 

 

Context Help command  

 

 
 

Use the Context Help command to obtain help on some portion of BatSound.  When you choose the 

Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.  Then click 

somewhere in the BatSound window, such as another Toolbar button.  The Help topic will be shown for 

the item you clicked. 

 

Note: Context Help is not available for all items.  

 

Shortcut 

 

Keys: SHIFT+F1 

 

 

Miscellaneous 

 

 

Title Bar 
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The title bar is located along the top of a window.  It contains the name of the application and document. 

 

To move the window, drag the title bar.  Note: You can also move dialog boxes by dragging their title 

bars. 

 

 

 

A title bar may contain the following elements: 

 

• Application Control-menu button 

• Document Control-menu button 

• Maximize button 

• Minimize button 

• Name of the application 

• Name of the document 

• Close button 

 

 

 

 

 

Scroll bars 

 

Displayed at the right and bottom edges of the document window.  The scroll boxes inside the scroll bars 

indicate your vertical and horizontal location in the document.  You can use the mouse to scroll to other 

parts of the document. 

 

 

 

Size command (Control menu) 

 

Use this command to display a four-headed arrow so you can size the active window with the arrow 

keys. 

 

 
 

After the pointer changes to the four-headed arrow: 

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.   

2. Press a DIRECTION key to move the border. 

3. Press ENTER when the window is the size you want. 

 

Note:  This command is unavailable if you maximize the window. 

 

Shortcut 

 

Mouse: Drag the size bars at the corners or edges of the window. 
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Move command (Control menu) 

 

Use this command to display a four-headed arrow so you can move the active window or dialog box 

with the arrow keys. 

 

 
 

Note:  This command is unavailable if you maximize the window. 

 

Shortcut 

Keys: CTRL+F7 

 

 

 

Minimize command (application Control menu) 

 

Use this command to reduce the BatSound window to an icon. 

 

Shortcut 

 

Mouse: Click the minimize icon    on the title bar. 

Keys: ALT+F9 

 

 

 

Maximize command (Control menu) 

 

Use this command to enlarge the active window to fill the available space. 

 

Shortcut 

Mouse: Click the maximize icon   on the title bar; or double-click the title bar. 

Keys: CTRL+F10 enlarges a document window. 

 

 

 

Next Window command (document Control menu) 

 

Use this command to switch to the next open document window.  BatSound determines which window is 

next according to the order in which you opened the windows. 

 

Shortcut 

 

Keys: CTRL+F6 

 

 

 

Close command (Control menus) 

 

Use this command to close the active window or dialog box. 

 

Clicking the Close icon    or double-clicking a Control-menu box is the same as choosing the Close 

command. 
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Note:  If you have multiple windows open for a single document, the Close command on the document 

Control menu closes only one window at a time.  You can close all windows at once with the Close 

command on the File menu. 

 

Shortcuts 

 

Keys:  CTRL+F4 closes a document window 

 ALT+F4 closes the BatSound window or dialog box 

    

 

Restore command (Control menu) 

 

Use this command to return the active window to its size and position before you chose the Maximize or 

Minimize command. 

 

 

 

Switch to command (application Control menu) 

 

Use this command to display a list of all open applications.  Use this "Task List" to switch to or close an 

application on the list. 

 

Shortcut 

 

Keys: CTRL+ESC  

 

 

Dialog Box Options 

 

When you choose the Switch To command, you will be presented with a dialog box with the following 

options: 

 

Task List 

Select the application you want to switch to or close. 

Switch To 

Makes the selected application active. 

End Task 

Closes the selected application. 

Cancel 

Closes the Task List box. 

Cascade 

Arranges open applications so they overlap and you can see each title bar.  This option does not 

affect applications reduced to icons. 

Tile 

Arranges open applications into windows that do not overlap.  This option does not affect 

applications reduced to icons. 

Arrange Icons 

Arranges the icons of all minimized applications across the bottom of the screen. 

 

 

 



     BatSound 
®

    

  

72 

APPENDIX A 
 

 

The basics of signal processing 

 

Acoustic signals 

 

Sound can be defined as a wave motion, usually in air. A periodic signal theoretically consists of an 

infinite number of identical sequences, each sequence comprising one period of the signal. Signals with 

a finite number of identical sequences are generally referred to as periodic as well. The frequency of the 

signal is measured in Hertz (Hz), and tells us how many identical sequences or cycles there are per 

second. In the diagram below, a periodic signal is shown. The period is T = 0.1 sec., corresponding to a 

frequency of 10 Hz (=1/T). 

 

 
 

 

In order to convert the motion of air particles into an electric signal, a microphone is used. For ultrasonic 

frequencies, special ultrasound microphones are required. An ultrasound detector (bat detector) can 

also be used to transform the ultrasonic frequency into an audible frequency. This makes it possible to 

store the transformed signals on an audio frequency cassette tape recorder. 
 

Getting the signal into the computer - sampling  

 

In the early days of signal processing, dedicated instruments were used to perform the different types of 

analyses, e.g. an oscilloscope to display the oscillogram and a spectrum analyzer to produce signal 

spectra. Such instruments certainly still exist and in many situations are the best alternative. However, 

with the very powerful computers available today, it is also possible to use a combination of software 

and hardware (computer + data acquisition board) to obtain a very cost-effective “all-in-one” 

instrument. 

 

Most signals are originally analog, i.e. they are defined for all time values and can be assigned any 

amplitude value. A digital device such as a computer requires digital data, so the analog signal first has 

to be sampled and then quantized. The amplitude of the analog signal is sampled at the sampling 

instants, and the obtained samples are then assigned to one of the quantization levels (see below). 
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Resulting binary coded samples: 100, 101, 111, 111, 111, 110, 101, 011, 001, 000, 000, 000, 001, 011 

 

 

Clearly, the resemblance between the original and the sampled signal is improved if samples are taken 

closer to each other. However, taking many samples per time unit increases the computational burden as 

well as the storage requirements, so some compromise has to be made. The so called sampling theorem 

states that the minimum sampling frequency (number of samples per second) is twice the highest signal 

frequency. This means that a signal containing frequencies between 20 Hz and 20 kHz has to be sampled 

at a rate of at least 40000 samples per second (a sampling frequency of 40 kHz). This is the lowest 

sampling frequency allowed. In practice, the sampling frequency is always chosen a little higher than 

this. 

 

If too low a sampling frequency is used, aliasing will occur. Aliasing means that the frequency of the 

sampled signal will be lower than that of the original signal, so obviously this will not give a true picture 

of the original signal. Consequently, it is a good idea to always make sure that the signal does not contain 

any frequencies above half the sampling frequency. This can be attained by low-pass filtering the signal 

prior to the sampling. Many data acquisition boards and sound cards have such an anti-aliasing filter 

built-in, which automatically adapts the cut-off frequency according to the chosen sampling frequency. 

 

The quantization process also affects the quality of the digitized signal, but in a different way. From the 

illustration above it should be clear that the original amplitude values are rounded off as the samples are 

quantized. This introduces an amplitude error, which can be perceived as an increase in the noise level. 

The maximum error is smaller the smaller the quantization interval is used. Since the quantization 

interval is determined by the number of binary digits (bits) used to represent each sample, the noise 

added by the quantization process will be smaller the more bits are used (i.e. 16 bits gives less noise than 

8 bits). 
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The oscillogram 

 

Signals can be analyzed in many ways. The most fundamental is to display the variations in voltage 

(sound pressure) versus time, which is often referred to as an oscillogram. Two examples from 

BatSound are shown below. The first shows a portion of a bat call sequence, while the second shows an 

expanded view of one of the pulses. 

 

 

 

A visual inspection of the oscillogram reveals some basic properties of the signal such as signal shape, 

time for one period and, in the case of pulse-shaped signals, pulse length and time between pulses 

(pulse interval). 
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The time for one period of the signal is usually measured by calculating the time between successive 

zero-crossings of the signal. Taking the reciprocal of that time gives the frequency corresponding to that 

particular period, which in most cases corresponds to the fundamental frequency of the signal. 

 

The power spectrum 

 

A complex signal, as opposed to a pure sine wave, consists of more than one frequency. The spectrum of 

a signal gives information about how much and with which phase each frequency contributes to the 

signal. Usually, the phase information is less interesting, so instead the magnitude of the spectrum is 

displayed (amplitude versus frequency). Alternatively, the signal power versus frequency can be 

displayed. In that case, we get a power spectrum.  

 

The most common method to calculate the spectrum of a digitized signal is the Fast Fourier Transform 

(FFT). This algorithm is computationally more efficient than a direct calculation of the spectrum. 

 

Below a few power spectra are shown, illustrating the terms fundamental frequency and harmonics. 

The upper diagram shows the power spectrum of a sine wave, consisting of one single frequency, in 

accordance with the theory. The power spectrum of a square wave is shown in the lower diagram. Notice 

the fundamental frequency component at about 1 kHz and the harmonics at about 3, 5, 7 and 9 kHz (a 

symmetric square wave only has odd harmonics). 
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The width of each peak is determined by the length of the time interval used to calculate the spectrum 

(the size or length of the FFT) and the time window used. If we simply cut a portion of the signal and use 

that to calculate the FFT, we say that a rectangular window is used. If we instead use a Hanning 

window, then samples at the beginning and end of the selected interval will get a lower amplitude than 

they originally had. Although it might seem that such a modification of the signal would result in an 

error in the representation of the signal, it turns out that this generally improves the appearance of the 

spectrum. There are a number of other windows too, but the Hanning window is generally considered a 

good all-round window. Below are two power spectra of the same signal (a sine wave at about 5 kHz) 

showing the difference between rectangular and Hanning windows. Notice the spectral leakage in the 

rectangular window case (the ideally very narrow peak is spread over a wide range of frequencies). The 

spectral leakage makes the detection of any other, weak frequency component impossible, and should 

thus be minimized. With a Hanning window, the situation is much improved. 

 

Please note that what is said above is true for stationary, periodic signals (e.g. sinusoids), but does not 

necessarily have to be true for other signal types. In particular, for signals of limited duration (e.g. bat 

calls), the rectangular window is often the best choice. Provided the signal amplitude is small at the 

beginning and end of the interval over which a single power spectrum is calculated, the spectral leakage 

is also small and the rectangular window should be used. This is usually the case when the power 

spectrum for an entire pulse is calculated. 
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As mentioned above, the size of the FFT affects the resolution (i.e. the ability to resolve closely located 

frequency components). The longer the FFT, the higher the frequency resolution. The diagrams below 

show power spectra for the same signal, but with different FFT size. The most common FFT algorithms 

assume the size (number of samples) to be 2N, where N is an integer, corresponding to possible FFT 

lengths of 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024 etc. 

 

 

 
 

 
 

 

 

The spectrogram 

 

As outlined in the section about the power spectrum, you have to select a limited time interval over 

which the spectrum is calculated. This of course means that the power spectrum cannot give any 

information about how the spectral content of the signal varies over time. In many applications, such 

information is highly useful though, and one way to obtain it is to calculate a large number of power 

spectra along the signal, and display this in a suitable form.  

 

One possible way to display it is to use a so-called waterfall diagram, which is a pseudo-3-d diagram. 

 

Another way is to display the information as a spectrogram, which simply is a frequency versus time 

diagram, where the power (or amplitude) is coded as different shades of gray or different colors. The 

spectrogram thus provides quite extensive information about the signal, much more than a zero-crossing 

analysis of the same signal would provide.  
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The parameters determining the appearance of the spectrogram include FFT size, window selection and 

overlap between successive FFTs. An overlap of 0% means that the “next” FFT will start right where the 

“current” ended, an overlap of 50% means that the next FFT will start in the middle of the time interval 

used to calculate the current FFT, etc. Usually, it is also possible to adjust the “power-to-color” 

mapping. 

 

Zero-crossing analysis 

 

Zero-crossing analysis can be used to obtain a diagram similar to a spectrogram. It is less informative 

though, e.g. it only shows the predominant frequency component (usually the fundamental frequency), 

and does not give any information on amplitude or power. 

 

The time between successive zero-crossings of the signal is used to calculate the period of the signal. 

Taking the reciprocal of this gives the frequency corresponding to that period. Usually, the result is 

averaged over several cycles of the signal, in order to obtain a smoother curve. 

 

Time domain analysis 

 

Various types of analysis can also be made in the time domain, i.e. using the oscillogram as a base. 

Bioacoustic signals (and bat sounds in particular) often consist of a series of pulses. The distribution of 

these pulses can provide some useful information. E.g. the time difference between successive pulses 

and the individual pulse lengths can be measured and displayed (usually in a bar graph).  
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APPENDIX B 
 

Filters 

 

Electronic filters are commonly used e.g. to remove undesired frequencies from a signal. This can be 

used to reduce the influence of noise or other disturbances in a signal or to separate two or more signals 

previously combined. A signal may have been “contaminated” by 50-(60-) Hz hum from the mains. A 

filter, which removes this particular frequency, leaving all other frequencies unaffected, will restore the 

signal. 

 

There are many ways to classify filters, one common is to look at the frequency response (selectivity) of 

the filter. A filter can have a lowpass, highpass, bandpass or bandstop response (there are also allpass 

filters, but these are beyond the scope of this overview). Each name indicates the influence of the filter 

on a band of frequencies, e.g. a lowpass filter would pass low frequencies while high frequencies would 

be significantly attenuated.  

 

The filter characteristics available in BatSound are: 

 

Lowpass Filter - removes/attenuates signals above the selected cut-off frequency. 

Highpass Filter - removes/attenuates signals below the selected cut-off frequency. 

Bandpass Filter - removes/attenuates signals below and above a selected band of frequencies.  

Bandstop Filter - removes/attenuates signals within a selected band of frequencies. 

 

Some commonly used terms to describe filters: 

 

Passband - The frequency range which ideally should pass signals with no attenuation. 

Stopband - The frequency range that ideally should attenuate signals completely. 

Transition band - The frequency range between the passband and the stopband. The narrower the 

transition band, the more selective filter. 

 

For each of the above filters, except the notch filter, you may also choose between Butterworth, 

Chebyshev (type 1) or Elliptic filter types. For experienced users, the User Defined filter type is also 

available. Please refer to chapter 10 (Filter command) for information on this. 

 

The Order of the filter determines the filter’s selectivity. A high order filter is more effective than a low 

order filter, in that the transition band is narrower. You may select filter order 2, 4, 6 or 8.  

 

 

Butterworth Filters  

 

A Butterworth filter has a maximally flat frequency response in the passband. This filter type is a 

common general-purpose filter.  

 

 

Chebyshev Filters 

 

A Chebyshev type 1 filter has a frequency response, which ripples throughout the passband. Commonly 

this filter type is characterized according to the amount of ripple in the passband (e.g., a “1 dB ripple 

Chebyshev filter” has a gain variation of 1 dB in the passband). The advantage of allowing a certain 
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ripple in the passband is that this considerably improves the sharpness of the transition between the 

passband and the stopband. This means that a filter with given selectivity requirements can be realized 

with a lower order using a Chebyshev filter compared to using a Butterworth filter.  

 

In BatSound, the following values for the passband ripple can be chosen: 0.1, 0.2, 0.5, 1, 2 or 3 dB. 

 

Allowing only a very modest ripple (0.1 or 0.2 dB) will decrease the transition band significantly 

compared with the Butterworth filter. 

 

 

Elliptic Filters 

 

While the Chebyshev filters had ripple in the passband, the elliptic filters (or Cauer filters) exhibit ripple 

in both the passband and the stopband. This results in an even narrower transition band. The amount of 

ripple in the passband is specified just like the Chebyshev filter, while the amount of ripple in the 

stopband usually is specified as the “maximum stopband gain” (or “minimum stopband attenuation”). 

Selecting a maximum stopband gain of e.g. -40 dB, ensures that the attenuation in the stopband is at 

least 40 dB relative to the gain in the passband.  

 

In BatSound, the following values for the passband ripple can be chosen: 0.1, 0.2, 0.5, 1, 2 or 3 dB, and 

for the maximum stopband gain: -20, -30, -40, -50, -60 or -70 dB. 

 

For the technically interested user, the Butterworth, Chebyshev and Elliptic filter types are realized by 

first designing an analog filter prototype of the respective type and then applying the bilinear 

transformation to obtain the digital filter which is then implemented in the software. 
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APPENDIX C 
 

Troubleshooting 

 

This section provides some tips and strategies for some of the most common problems you might 

encounter. 

 

Problem 

There is no sound when I choose the Play Sound command. 

 

Cause/solution 

1. Check the cables and connections in your system. Are the loudspeakers connected to the “Speakers” 

output jack?  

 

2. Does the sound file you are trying to play really contain any sound? Load another sound file or play 

the sound file using another application (e.g. the Windows Media Player). 

 

3.  Check the volume control and input channel selector settings of the sound card. There may be a knob 

on the sound card that controls the output level to the speakers. In addition to this, it is also possible to 

adjust playback and recording levels using the “volume control” utility that often comes with the sound 

card. Enabling/disabling of the input channels is usually also possible. The Windows Volume Control 

offers similar options. You can access the Windows Volume Control either by double-clicking the 

loudspeaker symbol to the right in the Windows task bar or by choosing Programs - Accessories - 

Multimedia - Volume Control from the Start menu. The figure below shows suitable settings to enable 

playing sound. Make sure that both the Wave and the Volume Control are set to a level high enough. 

 

 
 

Note: With certain sound cards you will have to use the sound card’s “volume control” utility software 

rather than the Windows Volume Control to change the recording/playback settings. 

Problem 
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The recordings I make don’t contain any sounds. 

 

Cause/solution 

1. Check the cables and connectors in your system. Is the cable from your sound source (e.g. tape 

recorder) connected to the appropriate input of the sound card (connecting a microphone to the line input 

will result in very weak recordings)? 

 

2. Check the volume control and input channel selector settings of the sound card. There may be a knob 

on the sound card that controls the output level to the speakers. In addition to this, it is also possible to 

adjust playback and recording levels using the “volume control” utility that often comes with the sound 

card. Enabling/disabling of the input channels is usually also possible.  

 

The Windows Volume Control offers similar options. You can access the Windows “Volume Control” 

(the name may be different on your system) either by double-clicking the loudspeaker symbol to the 

right in the Windows task bar or by choosing Programs - Accessories - Multimedia - Volume Control 

from the Start menu. If you use the Windows Volume Control, please note that there are separate sets of 

controls for recording and playback. Normally the playback controls are displayed automatically when 

you start the Volume Control. To show the recording controls instead, start the Volume Control and 

choose Properties from the Options menu, and check “Recording” in the “Adjust volume for” box: 

 

 
 

 

 

Problem 

When I try to launch BatSound I get the error message “Error in installation data”. 

 

Cause/solution 

Most likely this is because the installation code (serial number) was entered incorrectly during the 

installation. Please re-install BatSound and make sure the code is entered exactly as printed on the label 

in the User’s Manual. The code is case sensitive. 
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The figure below shows suitable settings to enable recording sound through the LINE input (which 

normally should be used). Checking the “Select” box is important! 

 

 
 

The “Line-In” control can also be shown in the “playback” volume control (see above), so you may 

change the volume for the recordings there as well. The “select” check box is only present in the 

“Recording Control” though. 

 

3. If you make a “mono” recording, some sound cards use only the left channel (or mixes both channels). 

Change the recording mode to “stereo” and view both channels to check if this is the cause of the 

problem. If so, use the “stereo” mode, but choose to view only the desired channel (see the Spectrogram 

settings command). 

  

Note: With certain sound cards, you will have to use the sound card’s “volume control” utility software 

rather than the Windows Volume Control to change the recording/playback settings. 

 

 

Problem 

There is severe distortion in the recordings I make. 

 

Cause/solution 

Make sure that the sound level from your sound source fits the input of the sound card. E.g. connecting 

the output of a tape recorder to the microphone input of the sound card is likely to result in a distorted 

sound. Connect the tape recorder to the LINE input instead, or use an attenuator to lower the signal level 

before connecting it to the microphone input. 

 

 

Problem  

There are dropouts or clicks during playback of sounds recorded with BatSound. 

 

Cause/Solution 

1. The system performance is not sufficient for recording with the parameters and sound format you 

have chosen. Try to make a recording with only oscillogram display. If this plays back OK, then the 

system performance is the problem. Refer to the Real-time spectrogram section for more information. 

 



     BatSound 
®

    

  

85 

2.  There could possibly be a hardware conflict (IRQ, DMA or address) between the sound card and 

other devices installed in your system. Please refer to the Windows Help for information on how to 

resolve hardware conflicts. 

 

 

Problem 

When I choose the Zoom In command the zoom level suddenly gets very large (i.e. a very small portion 

of the signal is stretched out over the window). 

 

Cause/Solution 

You may unintentionally have marked a very narrow section of the signal (the marked section may then 

look almost like the vertical cursor). The following commands may then give unexpected results, e.g. 

choosing Zoom In will cause an extremely small portion of the sound file to be displayed. 

  

If a power spectrum window is displayed, the time interval over which this is calculated will be 

automatically marked in the oscillogram/spectrogram. Choosing the Zoom In command will cause this 

interval to be zoomed. 

 

 

Problem 

There are no shades of gray/colors when I print out a diagram. 

 

Cause/Solution 

Make sure the printer is configured properly. Most printers have different operation modes selectable in 

the printer’s Properties dialog box.  

 

Please make sure you are using the latest printer drivers. Most printer manufacturers make new printer 

drivers available to download from their web sites. 

 

 

Problem 

When I try to print or copy a Power Spectrum, a Pulse Interval or a Pulse Length diagram I get the 

oscillogram (or spectrogram) instead.  

 

Cause/Solution 

The print command in the File menu and the Copy command in the Edit menu work on the main window 

only (containing the oscillogram and/or spectrogram). To print or copy diagrams from the other 

windows, use the Print or Copy command in the “right mouse button menu” of the respective window. 

To invoke this menu, position the mouse arrow anywhere in the Power Spectrum, Pulse Interval or Pulse 

Length diagram and then click the right mouse button. 

 

 

Problem 

I only get empty histograms when I make a Pulse Interval or Pulse Length analysis. 

 

Cause/Solution 

The Pulse Interval/Pulse Length parameter settings may have been inappropriately chosen.  

Check that: 

 

• The time scale covers the time range of interest for your analysis. 

• The detection threshold is not set too high. 

• The detection delay time is not too long for the signal you are analyzing. 

 

Please refer to the Commands section of this manual for more information on the use of the Pulse 

Interval/Pulse Length parameter settings. 
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Problem 

Marking the signal with the mouse does not work in both directions.  

 

Cause/Solution 

The current cursor type has to be “Measurement cursor” to enable marking of the signal in both 

directions. The cursor type is chosen in the Tools menu. 

 

 

Problem 

When I play a sound file in the Virtual Bat Detector mode, the tuned frequency does not change (or 

changes with a delay) as I press the arrow keys.  

 

Cause/Solution 

The computer's performance may be inadequate for the selected Virtual Bat Detector parameters (see 

above). Try a lower filter order and/or a lower speed factor if possible. On a sufficiently fast computer, 

the tuning indicator should move with no or small delay when you press the up/down arrow keys. 

 

 

Problem 

In the Virtual Bat Detector mode, the horizontal bar showing the tuned frequency is not visible. 

 

Cause/solution 

A spectrogram has to be displayed in the active window in order for the tuning control to be active. 

Make sure you have selected this before running the Virtual Bat Detector. 

 

 

 



     BatSound 
®

    

  

87 

 



     BatSound 
®

    

  

88 

INDEX 

 
 
Aliasing, 72 

Analysis menu 

Combined command, 57 

Oscillogram Settings command, 63 

Power spectrum command, 16, 57 

Power Spectrum Settings command, 64 

Pulse Feature Analysis command, 60 

Pulse interval/pulse length analysis command, 18, 

58 

Pulse Interval/Pulse Length Settings command, 

65 

Spectrogram command, 17, 55 

Spectrogram Settings command, 61 

Anti-aliasing filter, 72 

Bat detector, 71 

Heterodyne, 5, 23 

Time expansion, 5 

BatSound 

Commands overview, 27 

Installation, 9 

Comments, 48 

Continuous update mode, 57, 59, 65 

Edit menu 

Adjust Volume command, 40 

Clear/Silence command, 39 

Copy command, 38 

Cut command, 38 

Delete command, 39 

Filter command, 40 

Paste command, 39 

Reverse command, 40 

Select All command, 39 

Undo command, 38 

Exporting analysis data, 19 

FFT overlap, 61 

FFT size, 61, 64, 76 

FFT window, 61, 65 

File menu 

Close command, 32 

D500X/D1000X File Management, 34 

Export Graphics command, 33 

Import command, 33 

New command, 31 

Open command, 31 

Open next/previous command, 32 

Print command, 35 

Print Preview command, 36 

Print Setup command, 36 

Save As command, 33 

Save command, 33 

Save Selected Interval command, 33 

Filtering, 40, 79 

Help menu, 13, 68 

Marks, 54 

Oscillogram, 55, 73 

Playback of sound, 15, 46 

Power spectrum, 16, 57, 75 

Pulse Feature Analysis, 60 

Pulse interval/pulse length analysis, 18, 58 

Real-time spectrogram, 21 

Recording of sound, 11, 15, 46, 49 

Recording settings, 16, 48 

Right mouse button menu, 19 

Sampling, 71 

Sampling frequency, 48, 49, 72 

Sampling theorem, 72 

Sound card, 7, 46, 82, 83 

Sound menu 

Automatic recording command, 49 

Play Sound command, 46 

Play Speed command, 46 

Record Sound command, 46 

Sound devices command, 46 

Sound Format command, 48 

Stop... command, 47, 48 

Virtual Bat Detector command, 50 

Spectrogram, 17, 55, 76 

Color mapping, 62 

Color mapping – user defined, 62 

System Requirements, 7 

Time expansion factor, 16, 48 

Toolbar, 42 

Tools menu 

Active marks properties command, 54 

Clear all marks command, 55 

Default Zoom command, 51 

Level Cursor command, 53 

Mark distances command, 54 

Marking Cursor - Stereo command, 52 

Marking Cursor command, 52 

Measurement Cursor command, 52 

Move active mark command, 54 

Save cursor as mark command, 53 

Scroll to mark command, 55 

Set active mark command, 54 

Zoom Entire File command, 52 

Zoom In command, 51 

Zoom Out command, 51 

Troubleshooting, 26, 81 

Wave file format 

BatSound, 35, 47, 48 

BatSound compressed, 35 

Standard, 35 

Window function (FFT), 61, 75 

Virtual Bat Detector mode, 23, 50 

 


